
 

 

WS3500 - Metago
®
 Manager 

WS3500 - Metago
®
 Manager LITE 

994-T061 Rev Q  – March 2016 
 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Westronic Systems 
200, 550 71 Avenue SE 
Calgary, AB, Canada T2H 0S6 
Phone (403) 250-8304 
Fax (403) 263-2174 
 
 
All rights reserved.  No portion of this manual may be copied, reproduced or duplicated in any manner 
without prior permission from Westronic Systems. 
 
This manual is based on information available at the time of publication.  While every effort has been made 
to ensure its accuracy, the information contained herein may not cover all details or variations in hardware 
or software, nor may it provide every possible detail in connection with installation and operation. 
 
The information contained in this document is confidential to Westronic Systems and its owners.  The 
recipient of this information by its retention and use agrees to the confidential status of this the information 
contained herein. 
 
© Westronic Systems 2016. 
 
 



Metago Manager — Revision History 

994-T061 Rev Q – March 2016  i 
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4.1.23 June 22, 2005 DB Address change 
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About this document 

This manual provides detailed information on the Metago
®
 Manager and Metago Manager 

LITE software packages for configuring the WS3500 Metago
®
 RTU. 

This manual is divided up into the following sections: 

Overview — this section describes the function of the Metago
®
 Manager software 

application. 

System Requirements — this section describes the minimum requirements needed on 

your PC in order to run the application. 

Getting Started — this section describes the basics of using Metago
® 

Manager.  Some of 

the topics covered are how to start and exit the application and how to work within the 

application.  

Connecting to the RTU — this section describes how to connect to the RTU. 

Configuring the RTU — this section describes the various Tab that are used to configure 

an RTU and how to download the configuration from the PC to the RTU. 

Configuring TBOS Devices — this section describes how to add and delete TBOS 

devices, and modify the associated TBOS points.  

Configuring TABS Devices — this section describes how to add and delete TABS devices, 

and modify the associated points.  

Configuring TABS Reporting Devices — this section describes how to add and delete 

TABS Reporting devices, and modify the associated point mapping. 

Configuring INACS Devices — this section describes how to add and delete INACS 

devices, and modify the associated points.  

Configuring DS5000 Devices — this section describes how to add and delete DS5000 

devices, and modify the associated points.  

Configuring E2A Devices – This section describes how to add and delete E2A devices 

and modify the associated points. 

Configuring Derived Alarms – This section describes how to add, edit and delete Derived 

Alarm points to the WS3500 configuration. 

Options — this section describes the features listed in the Options menu.  

Using Templates — this section describes how to create and apply discrete, TBOS, and 

other templates to various RTUs. 

Saving and Restoring RTU Files — this section describes how to save the RTU file to your 

PC or disk and then how to restore (open) the saved file.  
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DB Loader— This section describes using the DB Loader utility included with Manager to 

import and export point configurations to .CSV files for easy manipulation. 
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Overview 

There are two varieties of Metago Manager that are available; they are referred to as 

Metago Manager and Metago Manager LITE.  Both include all configurable options for the 

WS3500.   

Metago Manager LITE is included free of charge with the purchase of a WS3500 RTU.  It 

is the single RTU variation of the application, where only one RTU can be configured at a 

time.  The user may connect to a WS3500, upload the current configuration, make 

changes, and download the changes back to the RTU. 

Metago Manager may be purchased from Westronic as an optional software package to 

be used with WS3500 RTUs.  Metago Manager includes all the features of Metago 

Manager LITE, with the added functionality of a database to store the configuration 

information of many RTUs.  This allows the user to make configuration changes offline, 

and then connect to the RTU and download the new configuration.  Metago Manager also 

includes several additional features that are not available in Metago Manager LITE. 

 Templates – Allows the user to export a block of point configurations to a .csv file, and 

import them so they can be reused in multiple locations. 

 DB Loader – An optional utility that allows the user to export / import all configured 

point for an RTU to a .csv file.  This allows for importing point configurations from 

other systems, or bulk point editing.   

 Network Database – Metago Manager’s RTU database can be stored either locally or 

on a network drive.  Metago Manager can be configured with a list of database 

partitions from which the user can select a database to use. 

Chapter 
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The Metago Manager and Metago
 
Manager LITE software packages are used to: 

 Connect and Upload the configuration on the RTU to the PC. 

 Download the configuration from the PC to the RTU. 

 Set the date and time on the RTU. 

 Enable or disable the InSite features. For more details on the use of InSite, please 

refer to the Metago InSite manual pn# 994-T066. 

 Configure the communications parameters on the RTU. These parameters include 

the TID, the RTU, router and netmask addresses for a LAN connection and/or a Line 

Modem connection. 

 Configure the WS3500 to report to a Host Management System via Simple Network 

Management Protocol (SNMP). 

 Configure the point definitions for the I/O modules. 

 Configure the serial ports on the RTU, their respective communication settings (data 

bits, parity, stop bits, and baud rate), and the point definitions for the devices 

connected to these ports. 

 Create user accounts. 

 Configure I/O correlation for the RTU. 

 Upgrade the version of firmware running on the Metago
®
 RTU. 

 Backup and Restore RTU configuration files. 

 View individual RTU Log files. 

 

 



Metago Manager — System Requirements 

994-T061 Rev Q – March 2016  3 

 

System Requirements 

To run Metago
®
 Manager on your PC, you require: 

 Windows XP/Vista/Win7/Win8 operating system 

 500MHz or faster microprocessor 

 A minimum of 128MB of RAM 

 CD drive (for installation) or use .zip file 

 A mouse, or other pointing device 

 

Installing the Metago® Manager Application From CD 

The Metago
®
 Manager application is installed using a standard Windows installation utility. 

To install the application, 

1. Insert the installation CD into the CD-drive. 

2. If your system is configured to AutoPlay CDs, the installation utility should be 

launched automatically, and you may skip to step 5. 

3. Start the Windows Explorer and browse to the root folder of the Metago Manager CD. 

4. Double-click on the file SETUP.EXE.  

5. The installation program will guide you through the subsequent steps. Simply follow 

the instructions as they appear on the screen.  

6. Select Finish when the installation process is completed. 

 

Installing the Metago® Manager Application From a .zip file 

The Metago
®
 Manager application is installed using a standard Windows installation utility. 

To install the application, 

1. Unzip the .zip file. 

2. Double click on setup.exe.  

3. The installation program will guide you through the subsequent steps. Simply follow 

the instructions as they appear on the screen. 

4. Select Finish when the installation process is completed. 

Chapter 
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Getting Started 

The user interface for Metago
®
 Manager is similar to many other Windows program. If you 

are familiar with other Windows applications, such as Microsoft Word, you may not have to 

read this “Getting Started” chapter (or perhaps a quick scan is all you need). 

This chapter covers how to: 

 Start and exit the Metago
®
 Manager application. 

 Work in the Metago
®
 Manager window. 

Starting Metago® Manager 

To access the Metago
®
 Manager utility,  

1. Click the Start button in the taskbar at the bottom of the screen. 

2. Move the mouse pointer over the All Programs item. The Programs menu appears. 

3. Move the mouse pointer over the Westronic folder and click the Metago Manager 

icon.  

 

Chapter 
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4. When accessing Metago Manager for the first time; the user is prompted to enter the 

license key. 

 

5. Enter the license key found on the outside of the CD envelope and click OK. The 

Metago Manager window appears (Figure 1). 

Exiting Metago® Manager 

To exit the application, you may choose File, and then Exit OR click on the close 

button in the upper-right hand corner of the main window. A confirmation dialog box 

appears. 

 

Click the OK button to exit the application. 

 

Working in the Metago Manager window   

 

Figure 1 - Metago Manager - Main window 



  Metago Manager — Getting Started 

994-T061 Rev Q – March 2016  7 

 

The following lists and describes the parts of the Metago Manager window shown in 

Figure 1. 

 Title bar — The title bar contains the Metago
®
 Manager icon (Westronic logo) along 

with the title of the application. Like all Word screens, the minimize, maximize, and 

close buttons are located in the upper right-hand corner of the title bar. 

 Menu bar — The menu bar contains the File, Options, and Help drop-down menus. 

From the File menu, you can choose Backup RTU, Restore RTU, and Exit items. The 

Options menu contains Enter license key, View log file, and Workgroups. The Help 

menu contains the About feature which displays the version of Metago™ Manager 

and a link to the Westronic web page. 

 Edit box — A box in which you can type and edit text, dates, or numbers. 

 List box — A list box contains more than one option from which to select. Most list 

boxes show only the current selection in what appears to be a text box, for example 

the Time Zone list in Figure 1. To see the entire list of options, click the down arrow to 

the side of the list. When the list is displayed (Figure 2), click the arrowheads in the 

scroll bar to scroll to the option you want. Then click the option in the list that you want. 

 

Figure 2-  Example of a drop-down list box 

 Tabs — Each Tab contains different options and parameters to be included in the 

RTU configuration. For example, the RTU Summary tab contains an overview of the 

RTU configuration, UPLOAD Config, DOWNLOAD Config, and Set RTU Date/Time. 

The Communications tab contains the Ethernet, line modem, and SNMP Host 

settings. You can switch between Tab by clicking on the appropriate tab. 

 Check box — A square box that can be turned on (enabled) or off (disabled). The 

option linked to the check box is enabled when a  appears in the box.  

 Button — buttons are used to execute or cancel a command. With the left mouse 

button, you click on the button to execute the command. You can also select a button 

by pressing the Tab key until the button is bordered in bold, and then pressing Enter. 

 Status bar — the status bar at the bottom of the screen shows connection status, 

username and permission level of the logged in user, along with the current date and 

time. 
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Connecting to the RTU with Metago Manager 

This section describes how to 

 Create a New RTU record. 

 Delete an RTU record. 

 Filter the Select RTU list to quickly find an RTU in the list. 

 Connect to and disconnect from an RTU. 

NOTE: Depending on the license purchased from Westronic, all fields shown in the 

various illustrative screenshots within this manual may not be present in your 

instance of Manager/Manager Lite.  Any fields that are not present do not need to be 

configured and may be ignored in this document. 

 

All these operations are performed in the Select RTU panel shown in Figure 3. 

 

Figure 3 - Metago Manager - Select RTU panel 

Creating a New RTU Record 

To create a new RTU record, 

1. Click on the New RTU button. The New RTU pop-up window appears. 

 

Figure 4 - New RTU pop-up window 

2. Enter the Target Identifier (TID) for that RTU. 

Chapter 
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The TID identifies the RTU and is the first parameter displayed in any autonomous 

TL-1 message. It is a maximum of 20 characters long, limited to letters, digits, and 

hyphens. The TID is case sensitive. In most cases, the TID is the RTU’s Common 

Language Location Identifier (CLLI). 

 

3. Click OK to close the New RTU pop-up window. The new RTU is added to the Select 

RTU list, with a default IP Address.  

 

4. Change the IP Address in the RTU Configuration panel and Save the change.  

By creating an RTU record that has an IP address and TID, you have enough information 

to allow you to connect to an RTU and upload the configuration of the RTU to your PC. To 

create a database for the new RTU record, refer to Configuring the RTU on page 16 to 

define the RTU’s ports, devices, and points. 

Filtering the RTU List 

To access an RTU quickly, you can select the Filter RTU List check box and enter part or 

the TID and/or IP Address of the RTU. 
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The RTUs displayed in the Select RTU list are filtered according to the information entered 

in the TID and/or IP Address text boxes. In the example above, all RTU records with TIDs 

that contain the number 2 appear in the list. The TID field is case sensitive. 

To remove the filtering, click on the Filter RTU List check box (remove the ). All the RTU 

records will once again be displayed in the Select RTU list. 

Deleting an RTU Record 

Deleting an RTU record, will delete the RTU records and all its ports, devices, and points. 

To delete an RTU record, 

1. Select the RTU in the Select RTU List. 

2. Click on the Delete RTU button. A Confirmation dialog box appears. 

 

3. Click the OK button to remove the record and all associated ports, devices, and 

points. 

Connecting to the RTU 

To connect to the RTU, 

1. Select the RTU in the Select RTU list.  

2. Click on the CONNECT button to establish a connection with the specified RTU. Once 

the RTU has been contacted, the RTU Login pop-up window appears. 
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3. Enter your username and password and click OK. An information dialog box appears 

indicating the status of your login. Each new Westronic WS3500 is shipped with a 

default Level 5 user of MTC with the password shipping. 

 

4. Click OK to close the Information dialog box. 

Figure 5 shows the buttons that become activated when you have connected to the 

RTU and the information that is displayed in the status bar at the bottom of the dialog 

box. 

At this point, the information displayed below the Select RTU panel does not 

necessarily reflect what is currently configured on the RTU. An UPLOAD Config 

operation must be performed to ensure the information displayed is what is currently 

on the RTU 

 

         

Figure 5 - Connecting to an RTU with Metago Manager 

When you have successfully connected and logged into an RTU, a text message is 

displayed under the DISCONNECT button. One of two text messages will be displayed, 

either:  

 RTU: IN SERVICE — This message indicates that Metago Manager is connected to 

the RTU, but the operation of the RTU has not been affected. The RTU is still 

processing alarms; InSite is still operational, etc. 
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 RTU: OUT OF SERVICE — This message indicates that all RTU processes have 

been suspended, and no alarms will be reported until the RTU is rebooted. An RTU is 

taken out of service when a download Config or upgrade firmware operation is 

performed.  

On a successful connection, the Reset RTU on disconnect check box is activated. If this 

option is selected, the RTU will reset on disconnection, regardless of whether the RTU is 

IN SERVICE or OUT OF SERVICE. If the Reset RTU on disconnect option is not 

selected, and the RTU is in service, the RTU will not reset on disconnection. 

Disconnecting from the RTU 

To disconnect from the RTU, click on the DISCONNECT button.  



Metago Manager — Connecting to the RTU with Metago Manager LITE 

994-T061 Rev Q – March 2016  14 

 

Connecting to the RTU with Metago Manager LITE 

This section describes how to connect to and disconnect from an RTU in Metago Manager LITE. 

All these operations are performed in the Select RTU panel shown in Figure 6 

 

Figure 6 -  Metago Manager LITE - Select RTU panel 

Connecting to the RTU 

To connect to the RTU, 

1. Enter the IP Address of the RTU in the IP Address field. 

2. Enter the Upgrade Port number.  (The default upgrade port number is 24) 

3. Click on the CONNECT button to establish a connection with the specified RTU. Once 

the RTU has been contacted, the RTU Login pop-up window appears. 

 

4. Enter your username and password and click OK. An information dialog box appears 

indicating the status of your login. Each new Westronic WS3500 is shipped with a 

default Level 5 user of MTC with the password shipping. 

 

5. Click OK to close the Information dialog box. 

Chapter 

5 
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Figure 7 shows the buttons that become activated when you have connected to the 

RTU and the information that is displayed in the status bar at the bottom of the dialog 

box. 

At this point, the information displayed below the Select RTU panel does not 

necessarily reflect what is currently configured on the RTU. An UPLOAD Config 

operation must be performed to ensure the information displayed is what is currently 

on the RTU 

 

 

Figure 7-  Connecting to an RTU with Metago Manager LITE 

When you have successfully connected and logged into an RTU, a text message is 

displayed under the DISCONNECT button. One of two text messages will be displayed, 

either: 

 RTU: IN SERVICE — This message indicates that Metago Manager is connected to 

the RTU, but the operation of the RTU has not been affected. The RTU is still 

processing alarms; InSite is still operational, etc. 

 RTU: OUT OF SERVICE — This message indicates that all RTU processes have 

been suspended, and no alarms will be reported until the RTU is rebooted. An RTU is 

taken out of service when a download Config or upgrade firmware operation is 

performed.  

On a successful connection, the Reset RTU on disconnect check box is activated. If this 

option is selected, the RTU will reset on disconnection, regardless of whether the RTU is 

IN SERVICE or OUT OF SERVICE. If the Reset RTU on disconnect option is not 

selected, and the RTU is in service, the RTU will not reset on disconnection. 
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Configuring the RTU 

This section describes  

 The contents of the tabs used to configure the RTU. 

 Uploading the configuration from the RTU to your PC 

 Downloading the configuration from your PC to the RTU 

 Setting the date and time on the RTU. 

NOTE: When using Metago Manager LITE, the configuration must be uploaded from the 

RTU prior to making changes and downloading.  This will ensure that the current RTU 

configuration is present in Metago Manager LITE.  Failure to do this may result in the loss of 

configuration information for an RTU. 

 

The RTU Summary Tab  

 

Figure 8-  RTU Summary Tab 

This tab contains an overview of the configuration of the selected RTU.  No RTU 

parameters can be changed directly from this tab.  All underlined blue text items on this 

tab are links that will redirect the user to the appropriate tab for editing the selected 

parameter.  Also included in the summary is a total point count, which includes all input, 

output, and health points for all configured devices. 

The RTU Summary tab also contains the UPLOAD Config, DOWNLOAD Config, and Set 

RTU Date/Time buttons. 

Chapter 

6 
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Uploading the Configuration 

The UPLOAD Config operation retrieves the current configuration from the RTU. Once the 

configuration is uploaded, configuration changes can be made, and later downloaded to 

the RTU.  If a new database has been built using Metago Manager and has not yet been 

downloaded to the RTU, do not UPLOAD, as this will overwrite the local database. 

Follow these steps to upload the configuration from the RTU into Metago Manager. 

1. Select the appropriate RTU from the Select RTU list. 

2. Click on the CONNECT button to establish a connection with the specified RTU. The 

RTU Login pop-up window appears. 

3. Enter a valid username and password and click the OK button.  

4. Select the RTU Summary tab. 

5. Click the UPLOAD Config button to upload the RTU’s configuration onto the PC. The 

following confirmation dialog box appears 

 

6. Click OK to continue the upload configuration operation. A pop-up window appears 

listing the files that are being uploaded from the RTU to your PC. 

 

7. Once the UPLOAD Config operation is complete, the following information dialog box, 

including the number of points uploaded, is displayed.  Click the OK button to close 

the dialog box. 

 

Metago Manager now contains the current RTU configuration. 
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Downloading the Configuration 

The DOWNLOAD Config operation sends the RTU configuration from PC to the RTU. 

1. Connect to the RTU. (Refer to Connecting to the RTU in Chapter 4 for further details.) 

2. Select the RTU Summary tab. 

3. Click the DOWNLOAD Config button. The following confirmation dialog box appears. 

 

4. Click OK to continue the DOWNLOAD Config operation. 

Note: Taking the RTU out of service immediately suspends all RTU operations. No 

alarms will be collected by the RTU or reported to the Host.  The RTU will return to In 

Service, once the DOWNLOAD Config operation has completed and the RTU has 

been reset. 

5. The Sending files to RTU… pop-up window appears outlining the progress of the 

DOWNLOAD Config operation. 

 

When the operation is successful, the following Information dialog box appears. 

 

6. Click Yes to disconnect and reset the RTU, and to return the RTU to IN SERVICE 

mode.  The RTU has now been updated with the new configuration. 
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Setting the Date and Time 

To set the date and time on an existing RTU, 

1. Connect to the RTU. (Refer to Connecting to the RTU in Chapter 4 for further details.) 

2. Select the RTU Summary tab. 

3. Click the UPLOAD Config button to ensure that the RTU is configured for the correct 

timezone. (Note: UPLOAD will overwrite any database that currently exists in 

Manager for the current RTU) 

4. Click the Set RTU Date and Time button to set the date and time on the RTU. The 

following dialog box appears.  

 

The override option allows the user to manually change the time that is to be set on 

the RTU.  This is not recommended, as Metago Manager has already compensated 

for timezone differences between the RTU and the PC. Provided that the PC’s clock is 

correct, the RTU will be set to the correct date and time. 

5. Click the DISCONNECT button to disconnect from the RTU. Note: there is no need to 

download the configuration or reset the RTU if the time zone and daylight saving 

parameters were not changed. 

6. Please see the “System Tab” section for information regarding use and configuration 

of NTP services. 
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The System Tab 

  

Figure 9 - System Tab 

The System Tab contains the following configuration items:  

 TID — The Target Identifier (TID) identifies the RTU and is the first parameter 

displayed in any autonomous TL-1 message. It is a maximum of 20 characters 

long, and is limited to letters, digits, and hyphens. The TID is case sensitive. In 

most cases, the TID is the RTU’s CLLI code (Common Language Location 

Identifier) Note: When restoring an RTU from a backup file, the TID in this field 

must match the TID in the RTU Backup File. 

 InSite — These check boxes enable/disable InSite Full or InSite Lite.  InSite is the 

web server optionally built into the RTU when licensed. When one or the other of 

these boxes is checked, the “InSite Options” panel on the right of the tab 

becomes visible, with available options as listed below in InSite Options. If both 

boxes are unchecked, the InSite options area of the Manager tab disappears and 

the InSite web browser will not be available on that RTU. For more information 

about InSite, please consult the InSite Manual (PN: 944-T066).  

 Timezone — This section allows the user to configure the timezone in which the 

RTU is located, as well as enable / disable Daylight Savings Time. 

 Heartbeat — This section allows the user configure the TL1 heartbeat.  With the 

heartbeat enabled, a TL1 event message is generated at the user-configured 

time intervals. 

 COM1 Timeout — This checkbox allows the user to disable (default) or enable a 

login inactivity timeout on the COM1 port at the front of the WS3500. 

Configuration range from 1 - 65535 minutes. Suggested range is 2-5 minutes. 

 Users — This section is used to configure the user accounts on the RTU.  The 

maximum number of users that are supported at one time is 15.  Each RTU is 

shipped with a default user of MTC with password shipping. The MTC user has a 

permission level of 5.  TL-1 command permissions are based on the permission 

level of their user account. Refer to the WS3500 Metago
®
 RTU Technical Manual  

(PN: 994-T062) for more information on TL-1 commands and messages.  
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 Firmware Version — Gives the version of firmware for the WS3500 which 

Manager is presently connected to, or if offline, the last firmware version uploaded 

to that unit from the current database. 

 Persistent Logging — This checkbox disables (default) or enables Persistent 

logging for WS3500’s having firmware 4.03.04 or newer. Operations Logs and 

TL1 logs will be retained following a reboot or power outage when this box is 

checked, up to the limit of the circular buffer. (Buffer sizes: Operations - 512 lines, 

TL1 – 2048 entries) 

 Alarm Delay — This checkbox disables (default) or enables Alarm reporting delay 

for WS3500’s having firmware 4.03.04 or newer. Valid delay time ranges from 1 

to 255 seconds. Delay Alarm delays the reporting of all alarms for the configured 

time following a reboot to prevent lost TL1 messages or SNMP traps. 

 InSite Options— This section enables Manager to configure the operation of 

certain aspects of user accessibility in the InSite or InSite Lite web browser. This 

in part depends on the license level originally purchased. i.e. Full InSite or InSite 

Lite. Functions that are not included in InSite Lite will be greyed out and cannot be 

changed. For more information on the use of InSite please see the Metago InSite 

manual (pn# 944-T066). 

-No System Info – InSite and InSite Lite. Checking this box removes the 

System Information and Operations Log pages from the web browser and 

replaces them with an “Access Restricted” banner. 

-No Controls – InSite only. Checking this box removes the Control Operate 

Request sub-page and replaces it with an “Access Restricted” banner. 

-No Force Points – InSite only. Checking this box removes the Force Point 

Request sub- page and replaces it with an “Access Restricted” banner. 

-No Reset Ports - InSite only. Checking this box removes the Reset Port 

Request sub-page and replaces it with an “Access Restricted” banner. 

 Enable NTP— This option allows the user to enable or disable (default) a 

WS3500 having firmware 4.03.04 and newer to synchronize with an NTP time 

server. Two timer server IP’s are available for configuration but both are not 

required. 
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Adding a User Account 

To add a user: 

1. Click the Add User button. The Add User window appears. 

 

Configure the following fields: 

 UserName — The user name is referred to as the uid (user identification) in the 

TL-1 command.  Maximum length is 10 alphanumeric characters. UserName is 

case sensitive. 

 Level — The level is referred to as the uap (user access privilege) in the TL-1 

commands.  Valid user levels are 1 to 5, 5 being the highest. Access to certain 

TL1 commands is restricted by a minimum user level requirement. Refer to the 

WS3500 Metago
®
 RTU Technical manual for more information on TL-1 

commands. 

 Password — The password is referred to as the pid in the TL-1 commands. The 

password must be a minimum of 1 character in length, and it cannot start with a 

number. The password is case sensitive. 

 Confirm Password — Re-enter the password. 

2. Click OK to close the Add User window, and add the new user. 

 

More About User Account Levels 

The TL1 activity allowed for each user level is defined in the WS3500 Metago
®
 RTU 

Technical Manual, Appendix A, WS3500 Supported TL1 Messages. Appendix A has the 

minimum required user level listed together with each command. 

User Levels also influence user activity within the WS3500 COM port CLI, through the 

InSite ® web browser (when licensed and enabled) and in Metago Manager. Please refer 

to the following three charts as to the effect user level has on these activities prior to 

creating users in Metago Manager. 
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User 
Level 

View 
Config. 

Modify 
Config. 

Ping 
Out 

View 
TL1 Logs 

View 
Ops Log 

Restart 
RTU 

1 Y N Y Y N N 

2 Y N Y Y N N 

3 Y N Y Y N N 

4 Y N Y Y N Y 

5 Y Y Y Y Y Y 

 

Table 1 User Level Matrix for COM 1 CLI Activities 

 

User 
Level 

Reset 
Ports 

Force 
Points 

Operate 
Controls 

Clear 
TL1 Log 

Clear 
Ops Log 

1 N N N N N 

2 N N N N N 

3 Y Y Y Y N 

4 Y y Y Y N 

5 Y Y Y Y Y 

 

Table 2 User Level Matrix for InSite® Activities 

 

User 
Level 

Upload Config 
from RTU 

Download 
Config to RTU 

Reset RTU on 
disconnect 

Set 
Time 

1 N N N N 

2 Y N N N 

3 Y N N N 

4 Y N Y N 

5 Y Y Y Y 

 

Table 3 User Level Matrix for Metago Manager® Activities 

 

Deleting a User Account 

To delete a user: 

1. Select the user to be deleted from the Users list. 

2. Click the Delete User button. A confirmation dialog box appears. 

 

3. Click OK to close the confirmation dialog box, and delete the user. 
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Editing a User Account 

To Edit a user: 

1. Select the user to be edited from the Users list. 

2. Click the “Edit User” button . The “Edit User” window is displayed. 

 

3. The Level and Password can be changed, however the level of the last ‘level 5’ user 

cannot be changed/downgraded. Click ‘OK’ when done. 

Note: You must DOWNLOAD Config and reset the RTU for user changes to take 

effect. 

The Communications Tab 

 

Figure 10 - Communications Tab 

The WS3500 may report to a Host Management System via TL-1 protocol, TABS or 

Simple Network Management Protocol (SNMP). The TL-1 protocol can report over a 

TCP/IP LAN or line modem dial-up connection.  TABS reporting can be configured over 

TCP/IP, or serial.  SNMP is only over a TCP/IP LAN connection. If the WS3500 is part of 

an SNMP-managed network, in addition to configuring the Ethernet Settings, you must 

also configure the SNMP Hosts. 
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The Communications Tab contains the following configuration items: 

Ethernet Settings 

 IP Address — An identifier for a computer or device on a TCP/IP network. 

Networks using the TCP/IP protocol route messages based on the IP address of 

the destination. The format of an IP address is a 32-bit numeric address written 

as four numbers separated by periods. Each number can be zero to 255. 

 Netmask — Used for administering networks, a netmask is a mask or screen 

used in conjunction with an IP address. The netmask allows network elements to 

extract the network ID and host ID from the IP address.  A frequently used 

netmask is 255.255.255.0. 

 Router — The router field must contain the IP address of a router on the same 

network segment at the RTU.  A router is a device that determines the next 

network point to which a data packet should be forwarded enroute toward its 

destination. 

 Upgrade Port — This is the TCP port used for communication between Metago 

Manager and an RTU.  In most cases, this port number will not be changed from 

the default value of 24. 

Note: Metago Manager actually uses two ports for upgrade, the upgrade port 

(base port) as well as a port 2 higher (base port + 2). For example, with the 

upgrade port set to 24, port 26 is also used in the for a Metago Manager 

connection. 

 Telnet Port — This is the TCP port used for upstream TL1 communication with a 

host.  In most cases, this port will not be changed from the default value of 23. 

Note: If the Telnet port is required to change, ensure that the new value does not 

conflict with the Upgrade ports or others such as SNMP host, TABS-IP etc. 

 Advanced…— This button displays the Advanced Ethernet Settings window, 

which contains the following settings:    
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o Enable DNS — This check box is used to enable / disable the DNS 

(Domain Name Server) configuration.  Currently, the only RTU feature 

that makes use of DNS is I/O Correlation with e-mail output. 

o Primary Name Server — The IP address of the primary DNS. 

o Backup Name Server 1 — (OPTIONAL)  The IP address of a backup 

DNS.  This server will only be used if the RTU is unable to contact the 

primary name server. 

o Backup Name Server 2 — (OPTIONAL)  The IP address of a second 

backup DNS.  This server will only be used if the RTU is unable to 

contact the primary name server or backup name server 1. 

o Gateway — The Default Destination IP as shown in the example above 

is the Router IP configured on the main area of the Communications 

Tab. Other IP addresses may be added if the WS3500 is communicating 

across several networks, such as when the unit is equipped with a 

Second NIC card.  

o Access Control — This panel allows the configuration of an Access 

Control List (ACL).  The ACL is a list of IP addresses which are permitted 

to connect to the selected RTU.  The ACL applies to Metago Manager 

upgrade connections, Telnet TL1 sessions, and TABSR over IP ports. 

The default setting in Manager is for ACL to be disabled. 

IMPORTANT NOTE: ACL behavior enforces that when one or more IP’s 

are configured, all others are excluded. Should a single, wrong IP be 

configured it will not be possible to remotely access the WS3500. The 

WS3500 would then need to be returned to Westronic under RMA for 

repair. Therefore it is highly recommended to configure several IP’s 

and ensure they are carefully verified prior to enabling ACL. 

o Secondary Ethernet Controller — A Secondary Ethernet controller is an 

option for the WS3500. Units having this option can be identified by 

contacting Westronic Technical Support with the part number of the unit, 

or by physically inspecting the main module for the presence of a 2
nd

 NIC 

card as outlined in the Main Board segment of the WS3500 Technical 

Manual (pn# 994-T062).   

The IP address of the 2
nd

 NIC card must be different to the primary 

address of the RTU and any of the other IP enabled options in its 

configuration. It may also need a second router address as outlined 

above in ‘Gateway’ 
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Modem Settings 

 Enable Modem — This check box is used to enable / disable the optional modem 

interface for regular dial-out reporting of alarms.  The modem can also be used 

for dial-up PPP connections, as well as Tl1 sessions using a standard VT100 

terminal. 

 Enable Dial Backup — This checkbox is used to enable / disable the modem for 

Dial Backup mode.  In dial backup mode, the RTU is configured to report alarms 

via Ethernet, and if the network connection to the host is lost, the optional 

WS3500 modem will dial-out to report alarms. 

 Dial Backup Timeout — In order for dial backup to work, the upstream host must 

be configured to issue a RTRV-HDR command at specified intervals.  This 

interval must also be configured on the RTU.  If a RTRV-HDR command is not 

received in this time interval, the RTU assumes that is has lost its connection to 

the host, and begins modem dial-out reporting of alarms.  Once the network 

connection has been restored, and the RTU begins receiving the RTRV-HDR 

commands again, the modem dial out reporting is terminated. 

 IP Address — This IP address is assigned as the local IP address of the RTU for 

a dial-up PPP session.  This field does not need to be configured if the modem 

interface will not be used for PPP sessions. 

 Router — The Router IP address is assigned as the remote IP address for a dial-

up PPP session.  This field does not need to be configured if the modem interface 

will not be used for PPP sessions. 

 Dial-out number — The dial-out number is a telephone number that the RTU will 

dial when a TL1 alarm or event occurs. On successful connection, the WS3500 

sends an ASCII stream including all new TL1 messages.  This field does not 

need to be configured if the dial-out alarm reporting feature will not be used. 

Note: The WS3500 Ethernet and the Modem PPP interface must be configured 

such that they are on different subnets, or IP routing problems may occur. 

TABS IP Reporting 

 Add port — Allows the addition of a TABSR IP port. 

 Delete Port — Allows the deletion of a TABSR IP port. 

 Edit Devices — Displays the TABSR Configuration window 

For information on the configuration of TABS Reporting, please see Configuring 

TABS Reporting in Chapter 10. 

SNMP Hosts 

 IP Address — The IP Address of the SNMP host. 

 Port — The TCP port used by the SNMP host. The default SNMP port is 162. 

 Version — The SNMP version to be used.  The WS3500 supports SNMP v.1 and 

SNMP v.2. 

 Community — The SNMP community to be joined by the WS3500. The 

community name is part of the SNMP message header. The community name 
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defines an access environment for a group of Network Management Systems 

(NMSs). 

 Advanced…— This button displays the Advanced SNMP Settings window, which 

contains the following settings: 

 

o Enable SNMP nag — This check box is used to enable / disable the 

SNMP nag feature. 

o Interval — The time interval at which standing alarms are retrapped. 

o Minimum severity — The minimum severity of standing alarms to be 

retrapped.  Any standing alarms of selected severity and higher will be 

retrapped. 

To add an SNMP Host,  

1. Click the Add Host button. The Add SNMP Host pop-up window appears. 

 

2. Configure all parameters. 

3. Click OK to save the configuration. The new host will be added to the SNMP Hosts 

list. 
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The Discrete Tab 

 

Figure 11 - Discrete Tab  

The Discrete Tab shows the I/O Modules that have been configured for the RTU. For each 

configured I/O module, Metago
®
 Manager automatically creates 1 Health point, 64 

discrete inputs, and 8 discrete outputs.  

The following operations are done from the Discrete tab: 

 Add I/O modules.  

 Delete I/O modules.  

 Edit point configurations for all I/O module points — health, inputs, and outputs. 

Adding an I/O Module 

To add an I/O module: 

1. Select the Discrete tab. 

2. Click the Add Module button. The Add I/O Modules pop-up window appears. 

 

3. I/O modules that are already configured will be grayed out. Check the module(s) to be 

added, and enter the CLLI code and workgroup (WG) to be applied to the new points.   

4. Click OK to add the I/O module. This closes the pop-up window and the new I/O 

module(s) will be displayed in the I/O Modules list.  
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Each I/O module point is assigned a unique AID.  The AID is a read-only field that is used 

to identify a point in a TL1 message.  The following is a description of the formatting for the 

AID parameter for I/O module points: 

 Discrete Inputs — DISCRETE-<I/O_module>-<point_number> 

Where: I/O module range is 1 – 8  

  point_number range is 1 – 64. 

 Discrete Outputs —DISCRETEC-<I/O_module>-<point_number> 

Where: I/O_module range is 1 – 8  

  point_number range is 1 – 8. 

 Discrete Health — HEALTH-IO-<I/O_module> 

Where: I/O_module range is 1 – 8. 

Removing an I/O Module 

To remove an I/O module: 

1. Select the Discrete tab. 

2. Select the I/O module to be deleted from the I/O Modules list. 

3. Click on the Delete Module button. 

Editing Discrete Input Points 

To edit discrete input points: 

1. Select the Discrete tab. 

2. Select the I/O module to be edited from the I/O Modules list. 

3. Click the Inputs button. The Edit Point Parameters window appears. 
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NOTE: Depending on the licence purchased from Westronic, all fields from the 

above screenshot may not be present.  Any fields that are not present do not need to 

be configured, and may be ignored in this document. 

 

4. Configure the points either by applying a template (refer to Using Metago Manager 

Templates – Chapter 17), or by editing the points individually.  Select the point from 

the point list and configure the Generic and Digital point parameters for each point.  

 

Generic point parameters 

 Alarm / Event / Alarm-Env  The Alarm, Event and Alarm-Environmental radio 

buttons configure whether the point is reported as an alarm, as an event or as an 

environmental alarm. See Appendix C, “Generic Point Parameters” for more 

information about how these reporting states differ. 

 Point Description  The Point Description field is a freeform text field to be used 

for a description of the point. Maximum length is 50 characters (punctuation 

characters are not recommended).  

 SID  The Source Identifier (SID) is a freeform text field that uniquely identifies a 

group of points.  The SID is used as the target identifier in the TL1 message 

header.  If the SID field is not configured, the RTU’s TID is used in its place. 

Maximum length is 20 characters. 

 AID Type  The AID Type is a freeform text field that can be used in conjunction 

with the AID to help identify a point.  This can be useful if the AID does not 

provide enough information to pinpoint the location of the point.  Maximum length 

is 10 characters. 

 Location  The Location is a freeform text field that is reported in the TL-1 alarm 

message.  This field is also referred to as the CLLI code, and is commonly used 

to identify the location of an alarm.  Maximum length is 11 characters.   

 WG  The workgroup (WG) is a two-character text field that is reported in the 

TL-1 alarm message.  This field is commonly used to determine which workgroup 

or department needs to be notified when this point changes state. 

 Cond Type  The Cond Type is a freeform text field that identifies the type of 

alarm or event being reported.  Maximum length is 10 characters. 

 Units — A four-character text field, describing the measurement unit of the field 

device. This field is not generally used for digital points. 

 Reporting State — A dropdown menu with three options: Disabled (default), 

Enabled, and InSite Only. In this dropdown menu changes can be made on a 

point by point basis. “Enabling or Disabling Points for an Entire I/O Module” 

describes a per display method and is found later in this section.  

 An alarm point set to the “InSite Only” state will report only on the InSite 

alarm summary webpage and will not be reported via TL1 or SNMP.  

Any alarm point included in a derived alarm expression will have its 

reporting state set to InSite Only automatically.  

Note: The default state of newly configured I/O module points is Disabled. 

Enabled or InSite Only must be selected from the dropdown list for the point to be 

reported when it changes state.  
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Digital parameters  

 Severity — The severity field can be set to one of five levels.  From highest to 

lowest severity, the levels are CR (Critical), MJ (Major), MN (Minor), RN 

(Routine), NA (Not Alarmed).  

 Normal State — The Normal State radio buttons are used to indicate which state 

is considered to be normal, and conversely, which state indicates an alarm 

condition. The default configuration is normally open, where a closed contact 

indicates an alarm. 

 Service Affecting— The Service Affecting radio buttons configure the point to be 

either SA (Service Affecting) or NSA (Non-Service Affecting). 

Download button 

This button enables the Manager user to update parameters of an individual point without 

the need to download an entire configuration and restart the WS3500. Please refer to 

Appendix B for more information on “Point on the Fly” usage.   

 

Editing Discrete Output Points 

To edit discrete output points:  

1. Select the Discrete tab. 

2. Select the I/O module to be edited from the I/O Modules list. 

3. Click the Outputs button. The Edit Point Parameters window appears. 

4. Configure the points either by applying a template (refer to Using Metago Manager 

Templates – Chapter 17) or by editing the points individually.  Select the point from 

the point list and configure the Generic and Digital point parameters for each point. 

Editing Discrete Health Points 

There is one health point that is automatically generated for each I/O module that is 

configured.  I/O module operation is verified at RTU start-up. If an I/O Module has been 

configured and is not found at start up, then the corresponding health point is alarmed.  

To edit discrete Health points:  

1. Select the Discrete tab. 

2. Select the I/O module to be edited from the I/O Modules list. 

3. Click the Health button. The Edit Point Parameters window appears. 

4. Configure the Health point by selecting the point from the list, and editing the Generic 

and Digital point parameters for each point. 

Enabling or disabling points for an entire I/O module 

To enable, disable or set to InSite Only all health, input, or output points on an I/O module: 
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1. Select the Discrete tab. 

2. Select the I/O module to be edited from the I/O Modules list. 

3. Click the appropriate button — Health, Inputs, or Outputs. The Edit Points Parameters 

window appears. 

4. Right-click in the point list, and a drop-down menu appears with the options Disable 

All, Enable All and InSite Only All. Two other options also appear in this drop down 

menu: Import Points… and Export Points…  For more information on Import/Export 

please refer to Chapter 17 – “Using Templates”. 

5. Select the Enable All to enable all points in the point list, Disable All to disable all 

points in the point list or InSite Only All to make all the points in the point list report in 

InSite only.  

The color of the circle in the leftmost column indicates whether the point is enabled, 

disabled or InSite Only.  Green indicates the point is enabled, red indicates the point is 

disabled and purple indicates the point is InSite only. 

 

 

 

 

 

The Serial Ports Tab 

 

Figure 12 - Serial Ports Tab 

The Serial Ports Tab contains configuration items regarding the RTU’s serial ports.  Also, 

any downstream devices (attached to RTU serial ports) are configured here, along with 

their alarm points. 
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The following operations are performed from the Serial Ports Tab: 

 Add a port. 

 Delete a port. 

 View and edit port configuration 

 Configure downstream serial devices. 

Creating a port 

To create a new port: 

1. Click the Add Port button. The Port Settings window appears. 

 

Figure 13 - Port Settings window 

 

2. The following are used to configure the serial ports: 

 Port — This list box contains all available serial ports on the RTU.  This list 

may include: 

  CRAFT, COM1 – RS232 ports on front panel of Main Module 

 Serial 1 – Serial 8 – 8 serial ports on rear RTU, jumper configurable  
RS232/RS485 

 Serial 11 – Serial 18 (Serial expansion 1) – Optional serial ports available 
with a Serial Expansion Module (541-T003) or Communications Module 
(536-3512) at address 1. 

 Serial 19 – Serial 26 (Serial expansion 2) – Optional serial ports available 
with a Serial Expansion Module (541-T003) or Communications Module 
(536-3512) at address 2. 

NOTE: In order for the expansion serial ports to appear in the Port list, the 

serial expansion module(s) must first be configured.  This is done on the 

Serial Ports tab.  In the Serial Expansion Modules section, select the 

appropriate configuration and click the Save button. 

 Type — Type field specifies the function of the port. The following screenshot 

of the dropdown menu shows all of the potentially available serial port types: 
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NOTE: Available port types are determined by the License Key purchased 

from Westronic, not all port types may be available on your configuration. 

 Console Port — by default, the COM 1 port is designated as a Console 
port. The Console port is used for accessing the Console Configuration 
Utility and for debugging purposes. 

 Craft Port — designating the port as a Craft Port provides a local TL-1 
interface using a terminal emulator session, such as HyperTerminal or 
TeraTerm. 

 Disabled — designating the port as disabled takes that port out of 
service.  

 DS5PA — designating the port as a DS5PA port allows the connection of 
one or more DS5000 devices to the port. 

 INACS — designating the port as an INACS port allows the connection 
of one or more INACS devices to the port. 

 PPP — designating the port as PPP allows for a direct serial PPP 
session. Additional configuration items are displayed in the Port Settings 
window when a port is configured as PPP.  These additional fields must 
be configured in order for PPP to function correctly. 

 Reachthrough — designating the port as a Reachthrough port provides 
the ability to connect to a serial device remotely, via a pass through IP 
connection.  Serial ports 1 – 8 may be used as Reachthrough ports, and 
are assigned fixed TCP ports 51 – 58 for telnet connections. Should 
lower and/or upper Serial Expansion modules be installed and 
configured for Reachthrough, their fixed TCP port ranges are 151-158 
and 251-258 respectively. 

 TABS — designating the port as a TABS port allows the connection of 
one or more TABS devices to the port.  

 TABS Reporting — designating the port as a TABS Reporting port 
enables the WS3500 to report configured alarms out the serial port in the 
TABS protocol. 
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 TBOS — designating the port as a TBOS port allows the connection of 
one or more TBOS devices to the port. 

 E2A — designating a port as an E2A port allows the connection of one or 
more E2A devices to the port. The correct dropdown option to configure 
is “E2A Collection”.  This can only be done on ports 11-18 or 19-26 when 
an E2A module has been configured under Serial Expansion Modules as 
either Slot 1 or Slot 2. For more information on E2A please see Chapter 
14 “Configuring E2A Devices” and the E2A supplement pn# 994-T080 
shipped with all WS3500 having an E2A communications module.  

 Note: Some Manager versions may also show “E2AP Collection” and 
“E2AP Reporting” as being available at the bottom of the port menu; 
newer versions will show these last two fields as “Future Use”. In either 
case these last two menu functions are not enabled and will have no 
effect on unit operation. 

 Data bits, Parity, Stop Bits, and Baud  — the port settings vary based on the 

type of device to be connected.  Below is a list of the typical port settings 

based on the port type: 

 Console Port —8 data bits, No Parity, 1 stop bit, 57600 baud. 

 Craft Port —8 data bits, No Parity, 1 stop bit, 57600 baud. 

 DS5PA —8 data bits, No parity, 1 stop bit, 1200 baud.  Refer to the 
DS5000 manual for more information. 

 INACS —8 data bits, No parity, 1 stop bit, 2400 baud.  Refer to the 
INACS device manual for more information. 

 PPP—The port settings must match the end device. 

 Reachthrough —The port settings must match the end device. Maximum 
speed, 57600 baud. 

 TABS —8 data bits, Odd parity, 1 stop bit, 2400 baud. 

 TBOS —8 data bits, Odd Parity, 2 stop bits, 2400 baud. 
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Additional Reachthrough Port Settings 

Checking or unchecking the ‘Console server compatible’ box changes the status of ALL 

ports configured as Reachthrough to that configuration. It is located in the lower right of the 

Serial Ports tab, only when a Reachthrough port is enabled. See screenshot below.  

 When the box is NOT checked (default) both <cr><lf> and <cr><NULL> (when 

received from the terminal emulator program) are passed through unchanged. 

 When the box IS checked (optional) both <cr><lf> and <cr><NULL> are passed 

through as <cr>. This adjustment may be needed when using the Reachthrough 

port to correctly interface with some devices. 

Note: This option only available in Manager 4.4.1 and newer when used together with 

WS3500 firmware 4.03.04 and newer. 

      

 
 
 

Reachthrough TCP/IP Port Assignment 

TCP/IP port assignment for all WS3500 Reachthrough ports is fixed in the firmware and 

allocated per the following: 

 Standard serial ports 1 – 8 may be used as Reachthrough ports, and are 

assigned fixed TCP ports 51 – 58 (respectively) for telnet connections.  

 Lower Serial Expansion module (when installed) has a physical serial port 

assignment of 11-18. When configured for Reachthrough, their fixed TCP port 

ranges are 151-158 respectively. 

 Upper Serial Expansion module (when installed) has physical serial port 

assignment of 19-26. When configured for Reachthrough, their fixed TCP port 

ranges are 251-258 respectively. 
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Additional PPP port settings 

 

 PPP Mode – A PPP Mode must be selected to determine how the PPP port 

functions.  In Listen mode, the PPP port waits for incoming PPP connections.  

In Attempt – Persistent mode, the port will continuously attempt to establish a 

PPP session.  In Attempt at startup mode, one attempt to establish a 

connection is made once when the RTU boots, and then the port enters 

Listen mode. 

 Local IP – If the RTU is to assert its own IP address, that IP Address must be 

entered in the Local IP field.  If this field is left blank, the remote end of the 

PPP connection must assign an IP address for the RTU. 

 Remote IP – If the RTU is to supply the remote end of the PPP connection 

with an IP address that IP address must be entered in the Remote IP field.  If 

this field is left blank, the remote end must have its Local IP address 

configured. 

Advanced polling parameters 

Most port types that are used to poll downstream devices also have some 

advanced polling parameters.  These parameters are accessed by clicking the 

Advanced >> button on the Port Settings window. 

 

 Message timeout – The message timeout begins immediately after a poll is 

sent to a downstream device.  If the configured timeout is exceeded before a 

response is received, the message is considered timed-out.  The message 

timeout value is in 100 millisecond increments, for example, the default value 

of 20 equals 2 seconds (20 x 100 ms = 2000 ms = 2 sec.). 
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 Error pause – The Error pause is the amount of time the RTU will pause after 

encountering a serial communications error.  The Error pause value is in 

seconds, and the default value is 4 seconds. 

 Number of retries – This is the number of poll retries when a timeout or 

response error occurs.  The default value is 3. 

3. Once all fields have been configured, click OK. If no devices are associated with the 

port type, port configuration is complete. If the port type accommodates downstream 

devices, the Configured Devices panel will be displayed on the Serial Ports Tab, 

below the Port Settings panel. To configure downstream devices, click the Edit 

Devices button. Refer to the protocol-specific sections in this manual for information 

how to configure devices.  

Deleting a port 

To delete a port: 

1. Select the port to be deleted from the Select Port list. 

2. Click on the Delete Port button. A confirmation dialog box appears. 

 

3. Click OK to delete the port, as well as all associated devices and points. 

Viewing the configuration of a port 

To view the port settings on a port, 

1. Select the port from the Select Port list. The Port Settings panel and Configured 

Devices panel (if applicable) will display the settings for that particular port.  To view 

more port settings, click the Edit Settings button.  This displays the port settings 

window, where all port parameters can be viewed. 

Editing the port settings 

To edit the port settings: 

1. Select the desired port from the Select Port list. The Port Settings panel and 

Configured Devices panel (if applicable) will display the settings for that particular port. 

2. Click the Edit Port button. The Port Settings window appears. 

3. Make the desired changes in the Port Settings window, and click OK to save your 

changes. 
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The I/O Correlation Tab 

I/O Correlation allows for the definition of actions to be taken when a point changes state.  

These actions may include activating a control output, sending a message on an 

alphanumeric pager, or sending an e-mail message. Refer to the Configuring Derived 

Alarms in Chapter 15 for details about the “Derived Alarms” button. 

 

Figure 14 - I/O Correlation Tab 

Creating a Correlation definition 

To add I/O correlations:  

1. Click the Add button on the I/O correlation tab. The Add/Edit entry window appears. 

 

2. For each correlation Input Point, the following fields must be configured: 

 AID —the AID of the input point. 

 Type — the point type of the input point. Currently only DIGITAL type input points 

are supported.  

 State — the state the input point must enter to activate the output. The state is 

either 0 (Off) or 1 (On). 

3. After the input point, the output point must also be configured. Different fields are 

needed based on the type of output point.  DIGITAL, PAGER, and EMAIL output 

types are supported. Following is a description of the fields associated with each type 

of output point.  
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DIGITAL output type requires configuration of the following parameters: 

 AID — the AID of the input point. 

 Type — the point type of the output point is set to DIGITAL  

 State — the target state the output point will enter when the input condition is met. 

The state is either 0 (Off) or 1 (On). 

 Mode — the type of control to be issued, either Latch (control remains on until it is 

released) or Momentary (control remains on for a specific amount of time, and 

then it is released).  

 Time — if the control type is Momentary, the Time field is displayed. This is the 

time interval (in milliseconds) for the output to remain in the defined target state. 

 

Figure 15 - Correlation - DIGITAL Output 

In the above screenshot, when digital input DISCRETE-1-1 goes into alarm, 

digital output DISCRETEC-1-1 will turn on for 2 seconds. 

PAGER output type requires no AID, therefore this field can be left blank.  The 

following parameters must be configured: 

 Type — the point type of the output point is set to PAGER  

 TAP Dial-In number — the telephone number of the TAP server.  This number 

should be available from the paging service provider. 

 Pager ID — the pager’s ID number.  This number should be available from the 

paging service provider. 

 

Figure 16 - Correlation - PAGER Output 

In the above example, when digital input DISCRETE-1-2 goes into alarm, a page will 

be sent to the TAP server at (403)555-1212, to be relayed to Pager ID 12345678. The 

pager message will contain the point CLLI, description, alarm severity, and timestamp. 
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The parameters in the page are delimited by an asterisk (*). Following is an example 

of a page: 

33:*CLGRYAB*LOW 

TEMPERATURE*MJ*Tue Aug 16 

17:29:01 2016 

EMAIL type requires no AID, therefore this field can be left blank.  The following 

parameters must be configured: 

 Type — the point type of the output point is set to EMAIL  

 To — the e-mail address to which the alarm message will be sent. 

 SMTP — the outgoing SMTP mail server you are using to send the message 

through.  This information should be available from network administration.   

Note: A corporate e-mail server may be suitable for use here. 

 CC —the e-mail address to which a CC of the alarm message will be sent.  This 

field is optional 

 Reply to — the e-mail address that will appear in the Reply-to field of the alarm 

message. 

 

Figure 17 - Correlation - EMAIL Output 

4. Click OK to close the Add/Edit entry window, and save the new correlation entry.  

Editing a Correlation Entry 

To edit a correlation entry: 

1. Select the entry to be edited from the list. 

2. Click the Edit button. The Add/Edit entry window appears. 

3. Modify the fields in the Add/Edit entry window and click OK to save the changes.  

Deleting a Correlation Entry 

To delete a correlation entry: 

1. Select the entry to be deleted from the list. 

2. Click the Delete button. The entry will be deleted from the list. 



  Metago Manager — Configuring the RTU 

 

994-T061 Rev Q – March 2016  43 

The Firmware Tab 

The Firmware Tab allows the user to perform a firmware upgrade on the RTU. The 

firmware upgrade package is a .zip file containing the files to be downloaded to the RTU. 

Upgrades to the RTU firmware should only be performed after consultation with, and 

approval from Westronic Systems Inc.  

Note: Interrupting a firmware upgrade, and in particular powering down the WS3500 

during this process, can result in an inoperable system.  Do not perform a firmware 

upgrade if the power to the unit may be removed. 

Upgrading the firmware 

To upgrade the firmware on the RTU: 

1. Connect to the RTU and upload the configuration. 

2. Select the Firmware tab. 

 

3. Click the Browse button, select and open the .zip file. The filename will be displayed in 

the Disk-On-Chip Upgrade (.zip file) panel. 

 

4. Click the Upgrade Firmware button to initiate the upgrade. A confirmation dialog box 

appears. 

 

Click OK to proceed with the upgrade. 

A status window appears, displaying the various files, which are being downloaded to 

the RTU. 
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After the upgrade is completed, the following Information dialog box appears 

 

5. Click Yes to disconnect and reset the RTU. The RTU will automatically reboot once 

the Metago Manager connection is terminated. Once the RTU has booted, the new 

firmware will be running, and the RTU will be returned to IN SERVICE mode. 
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The SLC Sequencer Tab 

The SLC Sequencer Tab allows the user to map points for the connection and monitoring 

of SLC devices. 

SLC devices can share some points (called SLC common Group), but each device (or 

terminal) has its own set of COT points.  In Metago Manager, the user must create a SLC 

Common Group, and then add COT points for each device.  The user can define one or 

more common groups, each having one or more COTs.  SLC Sequencer can be set up to 

use either Discrete (I/O module) points, TBOS (serial port) points or E2A points.  The 

points that are to be used for SLC sequencer must already be defined in the RTU 

configuration before they can be mapped as SLC points.  Once a point has been 

configured as SLC, it is no longer usable as a discrete, TBOS or E2A  point. To view an 

existing SLC or COT Group, click the “View Group” or “View COT” button after the 

selecting the item in question. 

NOTE:  The “Use BLB” checkbox in the SLC Options panel only needs to be checked if 

the BLB feature of the SLC protocol is to be used.  This adds the BLB point to the COT 

configuration window.  For the examples in this manual, BLB is not used. 

Adding a SLC Common Group 

To add a SLC common group: 

1. Select the SLC Sequencer tab. 

 

2. Use the Discrete Inputs, TBOS Inputs or E2A Inputs tabs to select what type of points 

to use for SLC sequencing.  (For this example, Discrete Inputs are used). 
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3. In the SLC Common Groups panel, Click the Add Group button.  The SLC Common 

Group window is displayed. 

 

4. Select the point range to be used.  If the first point (Major) is changed, all other points 

are automatically updated so that the points are in sequence.  When all points are 

configured correctly, Click the OK button. 

 

5. Click OK to proceed with the point mapping. 
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Adding a SLC COT 

1. Select the SLC Sequencer tab. 

2. In the COT panel, Click the Add COT button (This button is only enabled if there is a 

common group configured).  The SLC COT window is displayed. 

 

3. Select the input and output point ranges to be used.  Once all points are configured 

correctly, Click the OK button. 

 

4. Click OK to proceed with the point mapping. 
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Editing SLC Alarm Points 

1. Select the SLC Sequencer tab. 

2. Select the appropriate Common group, and COT. 

3. In the SLC Alarm Points panel, Click the Edit button.  The Edit Point Parameters 

window is displayed. 

 

 

 

4. Configure the points either by applying a template (refer to Using Metago Manager 

Templates – Chapter 17) or by editing the points individually. Select the point to be 

edited from the point list, then configure the Generic point parameters and the Digital 

parameters for each point.  

Generic point parameters 

Note: Some of the fields in the generic point parameters panel are populated when 

the SLC device is created.  Depending on the license purchased from Westronic, not 

all fields may be displayed. 

 Alarm / Event / Alarm-Env  The Alarm, Event and Alarm-Environmental radio 

buttons configure whether the point is reported as an alarm, as an event or as an 

environmental alarm. See Appendix C, “Generic Point Parameters” for more 

information about how these reporting states differ. 

 Point Description  The Point Description field is a freeform text field to be used 

for a description of the point. Maximum length is 50 characters (punctuation 

characters are not recommended).  

 SID  The Source Identifier (SID) is a freeform text field that uniquely identifies a 

group of points.  The SID is used as the target identifier in the TL1 message 

header.  If the SID field is not configured, the RTU’s TID is used in its place. 

Maximum length is 20 characters. 
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 AID Type  The AID Type is a freeform text field that can be used in conjunction 

with the AID to help identify a point.  This can be useful if the AID does not 

provide enough information to pinpoint the location of the point.  Maximum length 

is 10 characters. 

 Location  The Location is a freeform text field that is reported in the TL-1 alarm 

message.  This field is also referred to as the CLLI code, and is commonly used 

to identify the location of an alarm.  Maximum length is 11 characters.   

 WG  The workgroup (WG) is a two-character text field that is reported in the 

TL-1 alarm message.  This field is commonly used to determine which workgroup 

or department needs to be notified when this point changes state. 

 Cond Type  The Cond Type is a freeform text field that identifies the type of 

alarm or event being reported.  Maximum length is 10 characters. 

 Units — A four-character text field, describing the measurement unit of the field 

device. This field is not generally used for digital points. 

 Reporting State — A dropdown menu with three options: Enabled (default for 

SLC), Disabled, and InSite Only. From this dropdown menu changes can be 

made on a point by point basis instead of the per page basis as described in 

“Enabling and Disabling all SLC Points”, which is found later in this section.  

 An alarm point set to the “InSite Only” state will report only on the InSite 

alarm summary webpage and will not be reported via TL1 or SNMP.  

Any alarm point included in a derived alarm expression will have its 

reporting state set to InSite Only automatically.  

Note: Enabled or InSite Only must be selected from the dropdown list for the 

point to be reported when it changes state.  

 

Digital parameters  

 Severity — The severity field can be set to one of five levels.  From highest to 

lowest severity, the levels are CR (Critical), MJ (Major), MN (Minor), RN 

(Routine), NA (Not Alarmed).  

 Normal State — The Normal State radio buttons are used to indicate which alarm 

contact state is considered to be normal, and conversely, which state indicates an 

alarm condition. The default configuration is Open, where a closed contact 

indicates an alarm. 

 Service Affecting— The Service Affecting radio buttons configure the point to be 

either SA (Service Affecting) or NSA (Non-Service Affecting). 

Download button 

This button enables the Manager user to update parameters of an individual point without 

the need to download an entire configuration and restart the WS3500. Please refer to 

Appendix B for more information on “Point on the Fly” usage.   
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Enabling or disabling all SLC points 

To enable, disable or set to InSite Only all health, input, or output points on an I/O module: 

6. Select the Discrete tab. 

7. Select the I/O module to be edited from the I/O Modules list. 

8. Click the appropriate button — Health, Inputs, or Outputs. The Edit Points Parameters 

window appears. 

9. Right- click in the point list, and a drop-down menu appears with the options Disable 

All, Enable All and InSite Only All. Two other options also appear in this drop down 

menu: Import Points… and Export Points…  For more information on Import/Export 

please refer to Chapter 17 – “Using Templates”. 

10. Select the Enable All to enable all points in the point list, Disable All to disable all 

points in the point list or InSite Only All to make all the points in the point list report in 

InSite only.  

The color of the circle in the leftmost column indicates whether the point is enabled, 

disabled or InSite Only.  Green indicates the point is enabled, red indicates the point is 

disabled and purple indicates the point is InSite only. 

 

 

 

The IP Collection Tab 

The IP Collection Tab allows the user to map IP Addresses, TCP Ports and the 

corresponding protocols for collection over IP.  
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Adding an IP Collection Item. 

To add an IP Collection Item: 

1. On the IP Collection tab, click the “Add” button. The “Add IP Collection” window is 

displayed. Note: The WS3500 supports a maximum of 40 TABS-IP sessions. 

 

 

2. Enter the IP Address and TCP Port to connect to. Select the appropriate protocol from 

the dropdown list. Currently only TABS-IP-Collection is allowed. The Session Id is 

populated automatically with the first available Session Id, and cannot be changed.  

3. The session added in the step above would now appear in the grid and if this was the 

first session added, the “Configured Device” panel containing the  “Edit Device” button 

would appear beside the grid. To add devices on a particular session, select the 

session in the grid and click the “Edit Devices” button. The “TABS Configuration” 

window is displayed (because currently only TABS-IP-Collection is allowed). 

 



Metago Manager — Configuring the RTU 

52  994-T061 Rev Q  –  March 2016 

The Routing Tab 

The TL1 Routing Tab allows the user to map the TID, IP Address and TCP Port of 

downstream TL1 enabled devices through the WS3500 so that device’s alarms can be 

reported as part of the WS3500 alarms. Note: Any downstream alarms routed by the 

WS3500 will NOT be part of the InSite ™ summary; they will be reported as TL1 only.  

 

 

 

Adding a TL1 Routing Session 

To add a TL1 Routing Session: 

1. On the Routing tab, click the “Add” button. The “Add/Edit TL1 Routing entry” window 

is displayed.  Note: The WS3500 supports a maximum of 32  TL1 Routing sessions. 
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2. Enter the downstream TID, IP Address and TCP Port to connect with. If connecting 

over a standard IP session from a WS1800 the port will always be port 23. When 

collecting from a wireless modem enabled WS1800 this port selection must match the 

port configured in the WS1800 modem menu. For other devices, this port choice is 

configurable to any standard TCP port that may be needed. 

3. Click the “OK” button to add the entry to the TL1 Routing list. 
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Configuring TBOS Devices 

Serial ports may be configured as TBOS, which allows for the polling of up to 8 Telemetry 

Bit-Oriented Serial (TBOS) displays.  

This section describes how to configure TBOS inputs, outputs and health points. 

Adding TBOS displays 

1. Select the Serial Ports tab and create a TBOS port, or select one from the Select Port 

list. 

 

Figure 18 - Serial Ports - TBOS 

2. Click the Edit Devices button to configure devices on that port. The Edit Devices 

dialog box appears. 

 

Chapter 

7 
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3. Click the New Device button to add a device. 

 

Enter values for all of the following fields:  

 Display   Address of the TBOS display. The valid address range is 1 - 8.  

 CLLI – If a CLLI is entered here, it is applied to all points on the device. 

 WG – If the WG (workgroup) is selected here, it is applied to all points on the 

device. 

4. Click OK to save the changes and close the pop-up window. The Edit Devices 

window re-appears. 

5. Click the Close button to close the Edit Devices window.  

Deleting a TBOS display 

1. Click on the Serial Ports tab. 

2. Select the desired TBOS port from the Select Port list. 

3. Click the Edit Devices button. The Edit Devices window appears. 

4. Select the device from the Configured Devices list and click the Delete Device button. 

A confirmation dialog box appears. 

 

5. Click the Yes button to confirm the deletion.  

6. Click the Close button to close the Edit Devices window. 

TBOS Inputs 

For each configured TBOS serial port, there can be up to 8 displays, and each display has 

64 TBOS inputs. 

For each TBOS input point, there is an associated AID field. The AID is a read-only field 

that is automatically created by Metago
®
 Manager. For TBOS input points the format of 

the AID is TBOS-<port>-<display>-<point number>, where port is the serial port 

number (1-8 , 11-26), display is the display number (1-8), and point number is the TBOS 
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point number (1-64). For example, TBOS-6-1-64 indicates that the TBOS point is 

configured on serial port 6, display 1, and it is TBOS point 64. 

Editing TBOS Inputs  

To edit the TBOS inputs: 

1. Select the Serial Ports tab, and select the TBOS port to be edited from the Select Port 

list. 

2. Click the Edit Devices button. The Edit Devices window appears. 

 

3. Select the display to be edited from the Configured Devices list, and click the Inputs 

button. The Edit Point Parameters window appears. 

 

4. Configure the points either by applying a (refer to Using Metago Manager Templates 

– Chapter 17) or by editing the points individually. Select the point to be edited from 

the point list, then configure the Generic point parameters and the Digital parameters 

for each point.  
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Generic point parameters 

Note: Some of the fields in the generic point parameters panel are populated when 

you create a TBOS device.  Depending on the license purchased from Westronic, not 

all fields may be displayed. 

 Alarm / Event / Alarm-Env  The Alarm, Event and Alarm-Environmental radio 

buttons configure whether the point is reported as an alarm, as an event or as an 

environmental alarm. See Appendix C, “Generic Point Parameters” for more 

information about how these reporting states differ. 

 Point Description  The Point Description field is a freeform text field to be used 

for a description of the point. Maximum length is 50 characters (punctuation 

characters are not recommended).  

 SID  The Source Identifier (SID) is a freeform text field that uniquely identifies a 

group of points.  The SID is used as the target identifier in the TL1 message 

header.  If the SID field is not configured, the RTU’s TID is used in its place. 

Maximum length is 20 characters. 

 AID Type  The AID Type is a freeform text field that can be used in conjunction 

with the AID to help identify a point.  This can be useful if the AID does not 

provide enough information to pinpoint the location of the point.  Maximum length 

is 10 characters. 

 Location  The Location is a freeform text field that is reported in the TL-1 alarm 

message.  This field is also referred to as the CLLI code, and is commonly used 

to identify the location of an alarm.  Maximum length is 11 characters.   

 WG  The workgroup (WG) is a two-character text field that is reported in the 

TL-1 alarm message.  This field is commonly used to determine which workgroup 

or department needs to be notified when this point changes state. 

 Cond Type  The Cond Type is a freeform text field that identifies the type of 

alarm or event being reported.  Maximum length is 10 characters. 

 Units — A four-character text field, describing the measurement unit of the field 

device. This field is not generally used for digital points. 

 Reporting State — A dropdown menu with three options: Disabled (default), 

Enabled, and InSite Only. In this dropdown menu changes can be made on a 

point by point basis. “Enabling and Disabling all TBOS Inputs in a Display” 

describes a per display method and is found later in this section.  

 An alarm point set to the “InSite Only” state will report only on the InSite 

alarm summary webpage and will not be reported via TL1 or SNMP.  

Any alarm point included in a derived alarm expression will have its 

reporting state set to InSite Only automatically.  

Note: The default state of newly configured TBOS points is Disabled. Enabled or 

InSite Only must be selected from the dropdown list for the point to be reported 

when it changes state.  

 

Digital parameters  

 Severity — The severity field can be set to one of five levels.  From highest to 

lowest severity, the levels are CR (Critical), MJ (Major), MN (Minor), RN 

(Routine), NA (Not Alarmed).  
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 Normal State — The Normal State radio buttons are used to indicate which state 

is considered to be normal, and conversely, which state indicates an alarm 

condition. The default configuration is normally open, where a closed contact 

indicates an alarm. 

 Service Affecting— The Service Affecting radio buttons configure the point to be 

either SA (Service Affecting) or NSA (Non-Service Affecting). 

Download button 

This button enables the Manager user to update parameters of an individual point without 

the need to download an entire configuration and restart the WS3500. Please refer to 

Appendix B for more information on “Point on the Fly” usage.   

 

Enabling and disabling all TBOS Inputs in a Display 

To enable, disable or report in InSite only all TBOS points in a display: 

1. Select the Serial Ports tab. 

2. Select the TBOS port to be edited from the Select Port list. 

3. Click the Edit Devices button. 

4. Select the TBOS display to be edited from the list. 

5. Click the Inputs Button. The Edit Points Parameters window appears. 

6. Right- click in the point list, and a drop-down menu appears with the options Disable 

All, Enable All and InSite Only All. Two other options also appear in this drop down 

menu: Import Points… and Export Points…  For more information on Import/Export 

please refer to Chapter 17 – “Using Templates”. 

7. Select the Enable All to enable all points in the point list, Disable All to disable all 

points in the point list or InSite Only to make all the points in the point list report in 

InSite only.  

The color of the circle in the leftmost column indicates whether the point is enabled or 

disabled.  Green indicates the point is enabled, red indicated the point is disabled and 

purple indicates the point is InSite only. 

TBOS Outputs 

For each TBOS output point, there is an associated AID field. The AID is a read-only field 

that is automatically created by Metago® Manager. For TBOS output points the format of 

the AID is TBOSC-<port>-<display>-<point number>, where port is the serial port 

number (1-8 , 11-26), display is the display number (1-8), and point number is the TBOS 

point number (1-64). For example, TBOSC-6-1-64 indicates that the TBOS point is 

configured on serial port 6, display 1 and it is TBOS output point 64.  

Editing TBOS Outputs  

When a TBOS port is initially created, output points could optionally be added. If outputs 

were not added then, they can be added at any time. 
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To edit TBOS outputs:  

1. Select the Serial Ports tab. 

2. Select the TBOS port to be edited from the Select Port list. 

3. Click the Edit Devices button. The Edit Devices dialog box appears.  

4. Select the display to be edited. 

5. Click the Outputs button.  If the output points have already been created, go to step 6; 

otherwise  

a. The following message appears: 

 

b. Click OK to create the output points. All 8 TBOS displays will now contain 64 

output points. 

6. The Edit Point Parameters window appears. 

 

7. Configure the points either by applying a template (refer to Using Metago Manager 

Templates – Chapter 17) or by editing the points individually. Select the point from the 

point list, then configure the Generic point parameters and the Digital parameters for 

each point. Refer to “Generic Point Parameters” and “Digital Parameters” earlier in 

this chapter for the definitions of the parameters and more information. 

8.  



  Metago Manager — Configuring TBOS Devices 

994-T061 Rev Q – March 2016  61 

TBOS Health Points 

Each configured TBOS port, has one health point assigned to the port as a whole, and a 

health point for each configured display. Communication failures with individual TBOS 

displays will result in the associated display health point being alarmed. If all devices on a 

port are failed then the port health point is also alarmed.  

Table 4 lists the AID, point description, severity, and normal state for each TBOS Health 

Point, the x in the AID and point description refers to the serial port number. For example, 

HEALTH-6-0 would represent the TBOS Health point on serial port 6 and its default point 

description would be TBOS PORT 6 FAIL. 

AID Point Description Severity Normal State 

HEALTH–x-0 TBOS PORT x FAIL CR Open 

HEALTH–x–1 TBOS PORT x DISPLAY 1 MJ Open 

HEALTH–x–2 TBOS PORT x DISPLAY 2 MJ Open 

HEALTH–x–3 TBOS PORT x DISPLAY 3 MJ Open 

HEALTH–x–4 TBOS PORT x DISPLAY 4 MJ Open 

HEALTH–x–5 TBOS PORT x DISPLAY 5 MJ Open 

HEALTH–x–6 TBOS PORT x DISPLAY 6 MJ Open 

HEALTH–x-7 TBOS PORT x DISPLAY 7 MJ Open 

HEALTH–x-8 TBOS PORT x DISPLAY 8 MJ Open 

Table 4 TBOS Health Point Configuration 

Editing TBOS Health Points 

NOTE: Under normal circumstances, TBOS Health points will not need to be edited. 

To edit the TBOS Health points,  

1. Click on the Serial Ports tab. 

2. Select the TBOS port toe be edited from the Select Port list. 

3. Click the Edit Devices button. The Edit Devices window appears. 

4. Click the Health button. The Edit Point Parameters window appears with a list of all 9 

TBOS health points for that serial port. 

5. Configure each TBOS Health point by selecting the point in the point list then 

configuring the Generic point parameters and the Digital parameters. 

 

Enabling and disabling all TBOS points in a Display 

To enable, disable or report in InSite only all TBOS points in a display: 

1. Select the Serial Ports tab. 

2. Select the TBOS port to be edited from the Select Port list. 

3. Click the Edit Devices button. 

4. Select the TBOS display to be edited from the list. 

5. Click the appropriate button, Inputs, Outputs, or Health. The Edit Points Parameters 

window appears. 
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6. Right-click in the point list, and a drop-down menu appears with the options Disable 

All, Enable All and InSite Only All. 

7. Select the Enable All to enable all points in the point list, Disable All to disable all 

points in the point list or InSite Only to make all the points in the point list report in 

InSite only.  

The color of the circle in the leftmost column indicates whether the point is enabled or 

disabled.  Green indicates the point is enabled, red indicated the point is disabled and 

purple indicates the point is InSite only. 
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Configuring TABS Devices 

Serial ports configured as TABS will communicate with downstream devices using the 

Telemetry Asynchronous Block Serial (TABS) protocol.  

This section describes how to configure TABS serial ports, including addressing, displays, 

inputs, outputs and health points. 

Adding TABS devices 

1. Select the Serial Ports tab and either create a new TABS port or select one from the 

Select Port list. 

 

Figure 19-  Serial Ports – TABS Device 

2. Click the Edit Devices button to configure the downstream devices on the selected 

port. The TABS Configuration window appears.  

3. When TABS is configured for any given port, the ‘Point 64 Display Failure Alarm” 

checkbox becomes visible in the middle-right of the Serial Ports tab. Checking 

(enabling) this box causes the WS3500 to treat the 64
th
 point in each display as a 

communications failure alarm for that display. When this box is checked, if 

communication with that display is lost, a separate alarm will be generated by the 

WS3500 indicating the failure of that particular display. This alarm is in addition to the 

overall port health alarms normally generated by the WS3500. 

Note: Checking this box means any alarm physically connected to point 64 of the 

downstream device is ignored. Due to this behavior, point 64 is automatically labelled 

by Manager with a new point description.  

Eg “TABS Display 1 - Comm failure” 

Chapter 
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4. Click the desired Device Address button, and then click the Add button to add a TABS 

display at that address. The Adding a Device window appears. 

 

Enter values for the following fields:  

 Display  The display number of the TABS device. The valid address range is 0 

to 255. 

 CLLI  The CLLI code is a freeform text field in the TL-1 alarm message that is 

used to identify the location of an alarm. Maximum length is 11 characters. 

 WG  The WG (workgroup) is a two-character text field that is reported in the 

TL-1 alarm message. 

 Input points — Check this field to configure 64 input points. The CLLI and WG 

parameters will automatically be applied to the 64 input points.  

Note: Input points are always configured for TABS devices, and therefore cannot 

be de-selected. 

 Output points — Check this field to configure 64 output (control) points. The CLLI 

and WG parameters will automatically be applied to the 64 output points. 

5. Click the OK button to close the Adding a Device window. The TABS Configuration 

window reappears. 

6. If defining more than one display on that address, continue to click the Add button and 

define all the displays for that address. 
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7. Click the Close to save the changes and close the TABS Configuration window. The 

Serial Ports panel reappears. The total number of Configured Devices will be updated 

to display the total number of TABS devices on that serial port. 

Deleting TABS Displays 

1. Select the Serial Ports tab and select a TABS port from the Select Port list. 

2. Click the Edit Devices button. The TABS Configuration pop-up window appears. 

3. Select the display you wish to delete from the Displays list and click the Delete button. 

A confirmation dialog box appears. 

 

4. Click OK to confirm the deletion.  

5. Click the Close button to close the TABS Configuration window. 

TABS Inputs 

For each TABS input point, there is an AID field. The AID is a read-only field that is 

automatically created by Metago
®
 Manager.  For TABS input points, the format of the AID 

is TABS-<port>-<address>-<display>-<point number>, where port is the serial 

port number (1-8, 11-26), address is the device address number (0-31), display is the 

display number (0-255), and point number is the TABS point number (1-64). For example, 

TABS-7-0-1-64 indicates that the TABS point is configured on serial port 7, address 0, 

display 1, and it is input point 64. 

Editing TABS Inputs 

When a TABS display is created, 64 input points are automatically added. To edit these 

inputs: 

1. Select the Serial Ports tab and select the TABS port to be edited from the Select Port 

list. 

2. Click the Edit Devices button. The TABS Configuration window appears. 

3. Select the appropriate TABS display from the Displays list and click the Inputs button. 

The Edit Point Parameter window appears. 
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Figure 20 - Edit Point Parameters – TABS Inputs 

4. Configure the points either by applying a template (refer to Using Metago Manager 

Templates – Chapter 17) or by editing the points individually. Select the point from the 

point list then configure the Generic and Digital point parameters for each point.  

Generic point parameters  

Note: Some of the fields in the generic point parameters panel are populated when 

you created the TBOS device.  Depending on the license purchased from Westronic, 

not all fields may be displayed. 

 Alarm / Event / Alarm-Env  The Alarm, Event and Alarm-Environmental radio 

buttons configure whether the point is reported as an alarm, as an event or as an 

environmental alarm. See Appendix C, “Generic Point Parameters” for more 

information about how these reporting states differ. 

 Point Description  The Point Description field is a freeform text field to be used 

for a description of the point. Maximum length is 50 characters (punctuation 

characters are not recommended).  

 SID  The Source Identifier (SID) is a freeform text field that uniquely identifies a 

group of points.  The SID is used as the target identifier in the TL1 message 

header.  If the SID field is not configured, the RTU’s TID is used in its place. 

Maximum length is 20 characters. 

 AID Type  The AID Type is a freeform text field that can be used in conjunction 

with the AID to help identify a point.  This can be useful if the AID does not 

provide enough information to pinpoint the location of the point.  Maximum length 

is 10 characters. 

 Location  The Location is a freeform text field that is reported in the TL-1 alarm 

message.  This field is also referred to as the CLLI code, and is commonly used 

to identify the location of an alarm.  Maximum length is 11 characters.   
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 WG  The workgroup (WG) is a two-character text field that is reported in the 

TL-1 alarm message.  This field is commonly used to determine which workgroup 

or department needs to be notified when this point changes state. 

 Cond Type  The Cond Type is a freeform text field that identifies the type of 

alarm or event being reported.  Maximum length is 10 characters. 

 Units — A four-character text field, describing the measurement unit of the field 

device. This field is not generally used for digital points. 

 Reporting State — A dropdown menu with three options: Disabled (default), 

Enabled, and InSite Only. In this dropdown menu changes can be made on a 

point by point basis. “Enabling and Disabling all TABS Inputs” describes a per 

display method and is found later in this section.  

 An alarm point set to the “InSite Only” state will report only on the InSite 

alarm summary webpage and will not be reported via TL1 or SNMP.  

Any alarm point included in a derived alarm expression will have its 

reporting state set to InSite Only automatically.  

Note: The default state of newly configured TABS points is Disabled. Enabled or 

InSite Only must be selected from the dropdown list for the point to be reported 

when it changes state.  

 

Digital parameters  

 Severity — The severity field can be set to one of five levels.  From highest to 

lowest severity, the levels are CR (Critical), MJ (Major), MN (Minor), RN 

(Routine), NA (Not Alarmed).  

 Normal State — The Normal State radio buttons are used to indicate which state 

is considered to be normal, and conversely, which state indicates an alarm 

condition. The default configuration is normally open, where a closed contact 

indicates an alarm. 

 Service Affecting— The Service Affecting radio buttons configure the point to be 

either SA (Service Affecting) or NSA (Non-Service Affecting). 

Download button 

This button enables the Manager user to update parameters of an individual point without 

the need to download an entire configuration and restart the WS3500. Please refer to 

Appendix B for more information on “Point on the Fly” usage.   

 

 

Enabling and Disabling All TABS Inputs 

To enable, disable or report in InSite Only all TABS inputs in a display: 

1. Select the Serial Ports tab. 

2. Select the TABS port to be edited from the Select Port list. 

3. Click the Edit Devices button. 
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4. Select the TABS display to be edited from the list. 

5. Click the appropriate button, Inputs, Outputs, or Health. The Edit Points Parameters 

window appears. 

6. Right- click in the point list, and a drop-down menu appears with the options Disable 

All, Enable All and InSite Only All. Two other options also appear in this drop down 

menu: Import Points… and Export Points…  For more information on Import/Export 

please refer to Chapter 17 – “Using Templates”. 

7. Select the Enable All to enable all points in the point list, Disable All to disable all 

points in the point list or InSite Only to make all the points in the point list report in 

InSite only.  

The color of the circle in the leftmost column indicates whether the point is enabled or 

disabled.  Green indicates the point is enabled, red indicated the point is disabled and 

purple indicates the point is InSite only. 
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TABS Outputs 

For each TABS output point, there is an AID field. The AID is a read-only field that is 

automatically created by Metago
®
 Manager. For TABS output points the format of the AID 

is TABSC-<port>-<address>-<display>-<point number>, where port is the 

serial port number (1-8, 11-26), address is the device address (0-31), display is the display 

number (0-255), and point number is the TABS point number (1-64). For example, 

TABSC-7-0-1-64 indicates that the TABS point is configured on serial port 7, address 0, 

display 1, and it is output point 64. 

Editing TABS Outputs 

When creating a TABS display, the user is given the option of automatically creating 64 

output points.  If the output points are not added at that time, they can be added later. 

To edit TABS output points: 

1. Select the Serial Ports tab and select the TABS port to be edited from the Select Port 

list. 

2. Click the Edit Devices button. The TABS Configuration window appears. 

3. Select the TABS display to be edited from the Displays list and click the Outputs 

button. If the output points were not added when the TABS device was created, the 

following message box appears: 

 

Click OK to add the output points.  

4. The Edit Point Parameters window appears. 
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Figure 21 - Edit Point Parameters – TABS Outputs 

5. Configure the points either by applying a (refer to Using Metago Manager Templates 

– Chapter 17) or by editing the points individually. Select the point to be edited from 

the point list then configure the Generic and Digital point parameters for each point. 

See earlier in this chapter for definitions of the parameters. 

TABS Health Points 

Each configured TABS port, has one TABS health point for the entire port, and a health 

point assigned to each configured TABS address. Communication failures with individual 

address will result in the associated health point being alarmed. If all devices on a port fail, 

then the port health point is alarmed.  

Table 5 lists examples of AID, point description, severity, and normal state parameters for 

TABS health points. The x in the AID and point description represents the serial port 

number; the y represents TABS device addresses (0 – 31). For example, HEALTH-7-1 

would represent a TABS device on serial port 7, at address 1 and the default point 

description would be TABS PORT 7 ADDR 1. 

AID Point Description Severity Normal State 

HEALTH–x TABS PORT x FAIL CR Open 

HEALTH–x–y TABS PORT x ADDR y MJ Open 

Table 5 TABS Health Point Configuration 

Editing TABS Health Points 

To edit TABS Health points,  

1. Select the Serial Ports tab and select the TABS port to be edited from the Select Port 

list. 

2. Click the Edit Devices button. The TABS Configuration window appears. 
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3. Click the Health button. The Edit Point Parameters window appears. 

 

4. Configure TABS Health points by selecting the point from the point list, then 

configuring the Generic and Digital point parameters for each point. Refer to “Generic 

Point Parameters” and “Digital Parameters” earlier in this chapter for definitions of the 

parameters and more information.  
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Configuring TABS Reporting 

Serial ports configured as TABS Reporting will communicate with upstream hosts using 

the Telemetry Asynchronous Block Serial (TABS) protocol.  TABS Reporting can also be 

configured on TCP/IP ports for TABS over IP reporting. 

This section describes how to configure TABS Reporting ports, including addressing, 

mapped displays, inputs, and outputs. 

Adding TABS Reporting Ports 

1. For serial TABS reporting, select the Serial Ports tab and either create a new TABS 

Reporting port or select one from the Select Port list. 

 

Figure 22-  Serial Ports – TABS Reporting 

 For TABS over IP reporting, select the communications tab, and either add or select a 

TCP/IP port. 

 

Figure 23-  Communications – TABS over IP Reporting 

Chapter 
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2. Click the Edit Devices button to configure the mapped displays on the selected port. 

The TABSR Configuration window appears. 

 

3. Click the desired Device Address button, and then click the Add button to add a TABS 

display at that address. The TABSR Display Mapping window appears. 

 

Enter values for the following fields: 

Note: A mapped display for TABS Reporting can be configured with input points, 

output points, or both. 

 TABS Display  The display number of the TABS device. The valid address 

range is 0 to 255. 

 Input Points – Select Device   Select a device from the drop-down list of 

devices that are configured on the selected RTU.  Any device that contains digital 

input points can be mapped to a TABS display.  The # of points field is 

automatically populated based on the selected device. 

 Output Points – Select Device   Select a device from the drop-down list of 

devices that are configured on the selected RTU.  Any device that contains digital 

output (control) points can be mapped to a TABS display.  The # of points field is 

automatically populated based on the selected device. 

4. Click the OK button to close the TABSR Display Mapping window. The TABSR 

Configuration window reappears. 

5. If defining more than one display on that address, continue to click the Add button and 

define all the displays for that address. 
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6. Click the Close to save the changes and close the TABS Configuration window. The 

total number of Configured Devices will be updated to display the total number of 

mapped TABS devices on that port. 

Editing TABS Reporting Mapped Displays 

1. Select a TABS port from either the Serial Ports tab, or the Communications tab. 

2. Click the Edit Devices button. The TABSR Configuration window appears. 

3. Select the display you wish to edit from the Displays list and click the Edit button. 

4. The TABSR Display Mapping window appears.  Make desired changes. 

5. Click the Close button to close the TABSR Display Mapping window. 

Deleting TABS Reporting Mapped Displays 

1. Select a TABS port from either the Serial Ports tab, or the Communications tab. 

2. Click the Edit Devices button. The TABSR Configuration window appears. 

3. Select the display you wish to delete from the Displays list and click the Delete button.  

4. Click the Close button to close the TABSR Configuration window. 
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Configuring INACS Devices 

Serial ports configured as INACS will communicate with downstream devices using the 

Integrated Network Alarm & Control System (INACS) protocol.  

This section describes how to configure INACS serial ports, including INACS stations, 

status lines, outputs, and health points for each INACS device. 

Adding INACS devices 

1. Select the Serial Ports tab and either create an INACS port or select one from the 

Select Port list. 

  

 

Figure 24 - Serial Ports – INACS Device 

2. Click the Edit Devices button to configure the devices connected to the port. The 

INACS Configuration window appears. 

Chapter 
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3. Click the Add button to add a station (device). The Adding a Device window appears. 

 

Enter values for all of the following fields:  

 Station  The Station field represents the INACS station address. The supported 

range is 1 to 2046. Note: According to INACS Protocol, INACS station 0 is 

reserved for ALL Station usage and INACS station 2047 is reserved for INACS 

RTU dial-in, neither are supported by the WS3500.  

 Location (CLLI)  The CLLI code is a freeform text field that is reported in the TL-

1 alarm message. The CLLI code is a maximum of 11 characters long and is 

used to identify the site location of an alarm. 

 WG  The WG is a two-character text field that is reported in the TL-1 alarm 

message. 

4. Click the OK to close the window. The INACS Configuration window reappears. 

5. Configure Status Lines for a configured station.  

a. Click the numbered button corresponding to the status line to be added. A 

confirmation dialog box appears. 
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b. Click OK to close the confirmation dialog box. This automatically adds 32 

INACS inputs on that status line. A bolded status line number button in the 

INACS Configuration window indicates that the status line is configured, and 

32 INACS inputs have been added. 

6. Click the Close button to close the INACS Configuration window. The Serial Ports 

panel reappears. The total number of Configured Devices will be updated and display 

the total number of INACS stations (devices) on that serial port. 

Deleting INACS Stations 

1. Select the Serial Ports tab and select the INACS port to be edited from the Select Port 

list. 

2. Click the Edit Devices button. The INACS Configuration window appears. 

3. Select the station to be deleted from the Station list and click the Delete button. The 

station and all its associated points will be deleted. 

4. Click the Close button to close the INACS Configuration window. 

INACS Inputs 

For each INACS input point, there is an AID field. The AID is a read-only field that is 

automatically created by Metago
®
 Manager. For INACS input points, the format of the AID 

is INACS-<port>-<station>-<status line>-<point number>, where port is the 

serial port number (1-8, 11-26), station is the station address (1-2046), status line is the 

status line number (1-14), and point number is the INACS point number (1-32). For 

example, INACS-5-1-14-32 indicates that the INACS point is configured on serial port 5, 

station 1, status line 14, and it is input point 32. 

Editing INACS Inputs 

When a status line is added, 32 input points are automatically created. To edit these 

inputs: 

1. Select the Serial Ports tab and select the INACS port to be edited from the Select Port 

list. 

2. Click the Edit Devices button. The INACS Configuration window appears. 

3. Select the station to be edited from the Stations list and click the appropriate status 

line number button. The Edit Point Parameters window appears. 
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Figure 25 - Edit Point Parameters – INACS Inputs 

4. Configure the points either by applying a (refer to Using Metago Manager Templates 

– Chapter 17) or by editing the points individually. Select the point to be edited from 

the point list, then configure the Generic and Digital point parameters for the point.  

Generic point parameters  

Note:  Depending on the license purchased from Westronic, not all fields may be 

displayed. 

 Alarm / Event / Alarm-Env  The Alarm, Event and Alarm-Environmental radio 

buttons configure whether the point is reported as an alarm, as an event or as an 

environmental alarm. See Appendix C, “Generic Point Parameters” for more 

information about how these reporting states differ. 

 Point Description  The Point Description field is a freeform text field to be used 

for a description of the point. Maximum length is 50 characters (punctuation 

characters are not recommended).  

 SID  The Source Identifier (SID) is a freeform text field that uniquely identifies a 

group of points.  The SID is used as the target identifier in the TL1 message 

header.  If the SID field is not configured, the RTU’s TID is used in its place. 

Maximum length is 20 characters. 

 AID Type  The AID Type is a freeform text field that can be used in conjunction 

with the AID to help identify a point.  This can be useful if the AID does not 

provide enough information to pinpoint the location of the point.  Maximum length 

is 10 characters. 

 Location  The Location is a freeform text field that is reported in the TL-1 alarm 

message.  This field is also referred to as the CLLI code, and is commonly used 

to identify the location of an alarm.  Maximum length is 11 characters.   

 WG  The workgroup (WG) is a two-character text field that is reported in the 

TL-1 alarm message.  This field is commonly used to determine which workgroup 

or department needs to be notified when this point changes state. 
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 Cond Type  The Cond Type is a freeform text field that identifies the type of 

alarm or event being reported.  Maximum length is 10 characters. 

 Units — A four-character text field, describing the measurement unit of the field 

device. This field is not generally used for digital points. 

 Reporting State — A dropdown menu with three options: Disabled (default), 

Enabled, and InSite Only. In this dropdown menu changes can be made on a 

point by point basis. “Enabling and Disabling all INACS Inputs” describes a per 

display method and is found later in this section.  

 An alarm point set to the “InSite Only” state will report only on the InSite 

alarm summary webpage and will not be reported via TL1 or SNMP.  

Any alarm point included in a derived alarm expression will have its 

reporting state set to InSite Only automatically.  

Note: The default state of newly configured INACS points is Disabled. Enabled or 

InSite Only must be selected from the dropdown list for the point to be reported 

when it changes state.  

Digital parameters  

 Severity — The severity field can be set to one of five levels.  From highest to 

lowest severity, the levels are CR (Critical), MJ (Major), MN (Minor), RN 

(Routine), NA (Not Alarmed).  

 Normal State — The Normal State radio buttons are used to indicate which state 

is considered to be normal, and conversely, which state indicates an alarm 

condition. The default configuration is normally open, where a closed contact 

indicates an alarm. 

 Service Affecting— The Service Affecting radio buttons configure the point to be 

either SA (Service Affecting) or NSA (Non-Service Affecting). 

Download button 

This button enables the Manager user to update parameters of an individual point without 

the need to download an entire configuration and restart the WS3500. Please refer to 

Appendix B for more information on “Point on the Fly” usage.   

Enabling and Disabling all INACS Inputs 

To enable, disable or report in InSite only all INACS inputs in a display: 

1. Select the Serial Ports tab. 

2. Select the INACS port to be edited from the Select Port list. 

3. Click the Edit Devices button. 

4. Select the INACS display to be edited from the list. 

5. Click the Inputs button. The Edit Points Parameters window appears. 

6. Right- click in the point list, and a drop-down menu appears with the options Disable 

All, Enable All and InSite Only All. Two other options also appear in this drop down 

menu: Import Points… and Export Points…  For more information on Import/Export 

please refer to Chapter 17 – “Using Templates”. 
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7. Select the Enable All to enable all points in the point list, Disable All to disable all 

points in the point list or InSite Only to make all the points in the point list report in 

InSite only.  

The color of the circle in the leftmost column indicates whether the point is enabled or 

disabled.  Green indicates the point is enabled, red indicated the point is disabled and 

purple indicates the point is InSite only. 
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INACS Outputs 

For each INACS output point, there is an AID field. The AID is a read-only field that is 

automatically created by Metago
®
 Manager. For INACS output points, the format of the 

AID is INACSC-<port>-<station>-<point number>, where port is the serial port 

number (1-8, 11-26), station is the station address (1-2046), and point number is the 

INACS point number (1-256). For example, INACSC-5-1-32 indicates that the INACS 

point is configured on serial port 5, station 1, and it is output point 32. 

Editing INACS Outputs 

To edit output point parameters: 

1. Select the Serial Ports tab and select the INACS port to be edited from the Select Port 

list. 

2. Click the Edit Devices button. The INACS Configuration window appears. 

3. Select the appropriate INACS station from the Stations list and click the Outputs 

button.  If output points have not been added, a confirmation dialog box appears. 

 

Click OK to add the outputs and close the confirmation dialog box.  The Edit Point 

Parameters window appears. 

 

 

4. In the Edit Point Parameters window, click the Add Points button to add output points. 

The Add… window appears. 
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5. Enter the starting point number and the number of points to add. Click OK. The output 

points are added to the point list. 

 

Figure 26 - Edit Point Parameters – INACS Outputs 

6. Configure the points either by applying a (refer to Using Metago Manager Templates 

– Chapter 17) or by editing the points individually. Select the point to be edited from 

the point list, then configure the Generic and Digital point parameters for each point 

(refer to ‘Generic Point Parameters’ earlier in this section). 

7. Click the Close button when the output points are all configured. The INACS 

Configuration window re-appears. 
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INACS Health Points 

Each configured INACS port has an INACS health point for the entire port, and one health 

point for each configured INACS station. Communication failures with individual stations 

result in the associated health point being alarmed. If all stations on a port fail, then the 

port health point is alarmed.  

In addition to the Health points created automatically by Metago Manager, the INACS 

protocol supports additional health points called INACS TBOS port fail F-bit points. A 

TBOS FAIL point is automatically added when a new station is added. If the INACS device 

is in TBOS mode, it will report the TBOS PORT FAIL (F-bit) point if all the TBOS devices 

on that port fail. 

Table 6 lists examples of AID, point description, severity, and normal state for INACS 

health points and TBOS FAIL points. The x represents the serial port number (1-8, 11-26); 

the y represens the station on the INACS device (1 – 2046). For example, HEALTH-7-1 

would represent the INACS device on serial port 7 at station address 1, and its default 

point description would be TABS PORT 7 STN. 

AID Point Description Severity Normal State 

HEALTH–x INACS PORT x FAIL CR Open 

HEALTH–x–y INACS PORT x STN y MJ Open 

INACSFB-x-y INACS PORT x STN y TBOS PORT FAIL MJ Open 

Table 6 INACS Health Point Configuration 

Editing INACS TBOS PORT FAIL (F-BIT) Points 

If the INACS device is in TBOS mode, it will report the TBOS PORT FAIL (F-bit) point if all 

the TBOS devices on that port fail. To edit TBOS PORT FAIL points,  

1. Select the Serial Ports tab and select the INACS port to be edited from the Select Port 

list. 

2. Click the Edit Devices button. The INACS Configuration window appears. 

3. Select the INACS station to be edited from the Stations list.   

4. Click the TBOS FAIL button. The Edit Points window appears, listing the INACS F-bit 

points. Note: These points are automatically added when INACS stations are added. 
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5. Select the point to be edited from the point list, then configure the Generic and Digital 

point parameters for each point (refer to ‘Generic Point Parameters’ earlier in this 

section). 

6. Click the Close button to close the Edit Point Parameters window.  

Editing INACS Health Points 

To edit INACS Health points,  

1. Select the Serial Ports tab and select an INACS port from the Select Port list. 

2. Click the Edit Devices button. The INACS Configuration window appears. 

3. Click the Health button. The Edit Point Parameters window appears. 
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4. Configure INACS Health points by selecting the point in the point list, then configuring 

the Generic and Digital point parameters for each point. Refer ‘Generic Point 

Parameters’ earlier in this chapter for the definitions of the parameters. 
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Configuring DS5PA Devices 

Serial ports configured as DS5PA (DS5000 Protocol Acquisition) poll downstream RTUs 

using the DS5000 protocol.  

This section describes how to configure DS5PA serial ports, including stations, status 

lines, outputs, analogs and health points. 

Adding DS5PA devices 

1. Select the Serial Ports tab and either create a DS5PA port or select one from the 

Select Port list. 

 

Figure 27 - Serial Ports – DS5PA Device 

2. Click the Edit Devices button to configure the devices connected to the selected port. 

The DS5PA Configuration window appears. 

Chapter 

13 
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Figure 28 DS5PA Configuration dialog box 

3. Click the Add button below the Stations list to add a station. The Adding a Device 

window appears. 

 

Enter values for the following fields:  

 Address   The DS5000 station address. The supported range is 1 to 254.  

 Location (CLLI)   The CLLI code is a freeform text field that is reported in the 

TL-1 alarm message. The CLLI code is a maximum of 11 characters long and is 

used to identify the site location of an alarm. 

 WG  The WG is a two-character text field that is reported in the TL-1 alarm 

message. 

4. Click OK to close the Adding a Device window. The DS5000 Configuration window 

reappears with the new station displayed in the Stations list and Status Line 0 

(DS5000 system status points) automatically configured on that station. 
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5. Configure the Status Lines for that station.  

a. Click the Add button under the Status Lines list. The Status Lines window 

appears. 

 

b. Enter the status line number to be added and click OK to close the window. 

This automatically adds 32 DS5PA inputs on that status line. The DS5PA 

Configuration window reappears with the new Status Line displayed in the 

Status Lines list. 

c. Repeat the above process until all desired Status Lines are configured for 

that Station. The valid range of status lines is 0 to 16, with status line 0 

reserved for the system status points. (Refer to DS5PA Discrete Inputs later 

in this chapter for steps on how to modify the configuration of input points). 

6. Configure the Discrete Outputs for the station. 

a. In the DS5PA Configuration window, click the Outputs button. If the discrete 

output points were not previously defined, the following confirmation dialog 

box appears. 

 

b. Click OK to close the confirmation dialog box. The DS5PA Configuration 

window reappears. The text in the Outputs button is now bolded indicating 

that output points have been configured for that station. 

c. Click on the Outputs button to add output points. The Edit Point Parameters 

window appears with no points entered. 
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d. Click the Add Points button. The Add pop-up window appears. 

 

e. Enter the starting point number and the number of points to add. Click OK. 

The output points will be added to the point list. The maximum number of 

discrete control points per DS5PA station is 128 (range 1 to 128).  

 

 

f. Configure the points either by applying a template (refer to Using Metago 

Manager Templates – Chapter 17) or by editing the points individually. Select 

a point from the point list, then configure the Generic and Digital point 

parameters for each point (refer to Generic Point Parameters later in this 

chapter).   

g. Click the Close button to save the changes and close the Edit Point 

Parameters window. The DS5PA Configuration window reappears. 

7. Configure the TBOS Ports for the DS5000 station. 

a. In the DS5PA Configuration window, click the TBOS Ports button. The 

DS5PA TBOS Ports window appears. 
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b. Click the port button for the port to be edited. If the port has not already been 

added, the following message appears: 

 

c. Click the OK button to add the port; the DS5PA TBOS Displays window 

appears. All eight TBOS displays, containing 64 input points per display are 

automatically created (indicated by the bolded text on the Input Points 

Display buttons).  

 

There are two buttons associated with each Display in the Input Points panel. 

The numbers in brackets represent the point number. For example, Display 1 

(1 – 32) represents display 1, TBOS input points 1 to 32. Display 1 (33 – 64) 

represents display 1, TBOS input points 33 to 64. 

d. To configure the TBOS input points, click the appropriate Display button in 

the Input Points panel. The Edit Point Parameters window appears.  
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e. Configure the points either by applying a template (refer to Using Metago 

Manager Templates – Chapter 17) or by editing the points individually. Select 

the point from the point list, then configure the Generic and Digital point 

parameters for each point (refer to Generic Point Parameters later in this 

chapter). 

f. Click the Close button to save the changes and close the Edit Point 

Parameters window. The DS5PA TBOS Displays window box reappears. 

g. Repeat steps 7-d to 7-f until all the desired TBOS input points are configured 

on that port. 

h. To configure the TBOS Output Points, click the appropriate Display button in 

the Output Point panel in the DS5PA TBOS Displays window. If the output 

points have not been previously configured, the following message appears: 

 

i. Click the OK button to add the TBOS output points. The Edit Point 

Parameters window appears. 64 TBOS output points are automatically 

created. 

j. Configure the points either by applying a template (refer to Using Metago 

Manager Templates – Chapter 17) or by editing the points individually. Select 

the point to be edited from the point list, then configure the Generic and 

Digital point parameters for each point (refer to Generic Point Parameters 

later in this chapter). 

k. Click the Close button to save the changes and close the Edit Point 

Parameters window. The DS5PA TBOS Displays window reappears. 
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l. Repeat steps 7-h to 7-k until you have defined all the TBOS output points on 

that port. 

m. Close all the windows until the DS5PA TBOS Ports dialog box reappears. 

Repeat steps 7-a to 7-l until all desired TBOS ports have been added to the 

station. 

8. Configure the Analog points for the DS5000 Station. 

a. In the DS5PA Configuration window, click the Analogs button. The Analog 

Form window appears. 

  

b. Each DS5000 Shelf can have 8 analog points, for a maximum of 64 analogs 

for each DS5000 system. Select the analog group required. Analogs are 

further separated into Lines, starting at Line 151, each line containing 2 

analog points. Line 151, would contain Analog point 1 and Analog point 2, 

etc. 

  

c. Select the Line # button for the analog points to be added. The Edit Points 

Parameter window appears. 
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d. Configure the points either by applying a template (refer to Using Metago 

Manager Templates – Chapter 17) or by editing the points individually. Select 

the point from the point list, then configure the Generic and Analog 

parameters for each point (refer to Generic Point Parameters later in this 

chapter). 

e. Click the close button to save the changes and close the Edit Point 

Parameters window.  The DS5PA Analog Lines box appears. 

f. Repeat steps 8-b to 8-e until all the desired Analog input points are 

configured on that shelf. 

9. Click the Close button to close all the windows until the DS5PA Configuration window 

appears. Repeat steps 3 to 7 above until all the required stations associated with the 

DS5PA serial port have been added.  

Deleting DS5PA Stations 

1. Select the Serial Ports tab and select the DS5PA port to be edited from the Select 

Port list. 

2. Click the Edit Devices button. The DS5PA Configuration window appears. 

3. Select the station to be deleted from the Station list and click the Delete button below 

the Stations list. The station and all its associated points will be deleted. 

4. Click the Close button to close the DS5PA Configuration window. 

DS5PA Discrete Inputs 

For each DS5PA discrete input point, there is an AID field. The AID is a read-only field that 

is automatically created by Metago
®
 Manager. For DS5PA discrete input points, the format 

of the AID is DS5PA-<port>-<station>-<status line>-<point number>, 

where port is the serial port number (1-8, 11-26), station is the station address (1-254), 

status line is the status line number (0-16), and point number is the DS5PA point number 
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(1-32). For example, DS5PA-5-1-14-32 indicates that the DS5PA point is configured on 

serial port 5, station 1, status line 14, and it is input point 32. 

Editing DS5PA Discrete Inputs 

When a status line is added, 32 input points are automatically created. To edit these 

inputs: 

1. Click the Serial Ports tab and select the DS5PA port to be edited from the Select Port 

list. 

2. Click the Edit Devices button. The DS5PA Configuration window appears. 

3. Select the station to be edited from the Stations list, then select the desired status line 

from the Status Lines list.  Click the Edit button. The Edit Point Parameters window 

appears. 

 

Figure 29 - Edit Point Parameters – DS5PA Discrete Inputs 

4. Configure each of the DS5PA input points, either by applying a template (refer to 

Using Metago Manager Templates – Chapter 17) or by editing the points individually. 

Select the point to be edited from the point list, then configure the parameters for that 

point.  

Generic point parameters  

Note:  Depending on the license purchased from Westronic, not all fields may be 

displayed. 

 Alarm / Event / Alarm-Env  The Alarm, Event and Alarm-Environmental radio 

buttons configure whether the point is reported as an alarm, as an event or as an 

environmental alarm. See Appendix C, “Generic Point Parameters” for more 

information about how these reporting states differ. 

 Point Description  The Point Description field is a freeform text field to be used 

for a description of the point. Maximum length is 50 characters (punctuation 

characters are not recommended).  
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 SID  The Source Identifier (SID) is a freeform text field that uniquely identifies a 

group of points.  The SID is used as the target identifier in the TL1 message 

header.  If the SID field is not configured, the RTU’s TID is used in its place. 

Maximum length is 20 characters. 

 AID Type  The AID Type is a freeform text field that can be used in conjunction 

with the AID to help identify a point.  This can be useful if the AID does not 

provide enough information to pinpoint the location of the point.  Maximum length 

is 10 characters. 

 Location  The Location is a freeform text field that is reported in the TL-1 alarm 

message.  This field is also referred to as the CLLI code, and is commonly used 

to identify the location of an alarm.  Maximum length is 11 characters.   

 WG  The workgroup (WG) is a two-character text field that is reported in the 

TL-1 alarm message.  This field is commonly used to determine which workgroup 

or department needs to be notified when this point changes state. 

 Cond Type  The Cond Type is a freeform text field that identifies the type of 

alarm or event being reported.  Maximum length is 10 characters. 

 Units — A four-character text field, describing the measurement unit of the field 

device. This field is not generally used for digital points. 

 Reporting State — A dropdown menu with three options: Disabled (default), 

Enabled, and InSite Only. In this dropdown menu changes can be made on a 

point by point basis. “Enabling and Disabling all DS5PA Discrete Inputs” 

describes a per display method and is found later in this section.  

 An alarm point set to the “InSite Only” state will report only on the InSite 

alarm summary webpage and will not be reported via TL1 or SNMP.  

Any alarm point included in a derived alarm expression will have its 

reporting state set to InSite Only automatically.  

Note: The default state of newly configured DS5PA points is Disabled. Enabled or 

InSite Only must be selected from the dropdown list for the point to be reported 

when it changes state.  

 

Digital parameters  

 Severity — The severity field can be set to one of five levels.  From highest to 

lowest severity, the levels are CR (Critical), MJ (Major), MN (Minor), RN 

(Routine), NA (Not Alarmed).  

 Normal State — The Normal State radio buttons are used to indicate which state 

is considered to be normal, and conversely, which state indicates an alarm 

condition. The default configuration is normally open, where a closed contact 

indicates an alarm. 

 Service Affecting— The Service Affecting radio buttons configure the point to be 

either SA (Service Affecting) or NSA (Non-Service Affecting). 

Download button 

This button enables the Manager user to update parameters of an individual point without 

the need to download an entire configuration and restart the WS3500. Please refer to 

Appendix B for more information on “Point on the Fly” usage.   
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Enabling and Disabling all DS5PA Discrete Inputs 

To enable, disable or report in InSite only all DS5PA inputs in a display: 

1. Select the Serial Ports tab. 

2. Select the DS5PA port to be edited from the Select Port list. 

3. Click the Edit Devices button. 

4. Select the DS5PA display to be edited from the list. 

5. Click the Inputs button. The Edit Points Parameters window appears. 

6. Right- click in the point list, and a drop-down menu appears with the options Disable 

All, Enable All and InSite Only All. Two other options also appear in this drop down 

menu: Import Points… and Export Points…  For more information on Import/Export 

please refer to Chapter 17 – “Using Templates”. 

7. Select the Enable All to enable all points in the point list, Disable All to disable all 

points in the point list or InSite Only to make all the points in the point list report in 

InSite only.  

The color of the circle in the leftmost column indicates whether the point is enabled or 

disabled.  Green indicates the point is enabled, red indicated the point is disabled and 

purple indicates the point is InSite only. 

DS5PA Discrete Outputs 

For each DS5PA discrete output point, there is an AID field. The AID is a read-only field 

that is automatically created by Metago
®
 Manager. For DS5PA discrete output points, the 

format of the AID is DS5PAC-<port>-<station>-<point number>, where port is the 

serial port number (1-8, 11-26), station is the station address (1-254), and point number is 

the DS5PA point number. For example, DS5PA-5-1-32 indicates that the DS5PA point is 

configured on serial port 5, station 1, and it is discrete output point 32. 

Editing DS5PA Discrete Outputs 

To edit the discrete output points: 

1. Select the Serial Ports tab and select the DS5PA port to be edited from the Select 

Port list. 

2. Click the Edit Devices button. The DS5PA Configuration window appears. 

3. Select the DS5PA station to be edited from the Stations list and then click the Outputs 

button. The Edit Point Parameters window appears. 
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Figure 30 - Edit Point Parameters – DS5PA Outputs 

4. To add points, click the Add Points button. 

5. Configure the points either by applying a template (refer to Using Metago Manager 

Templates – Chapter 17) or by editing the points individually. Select the point to be 

edited from the point list, then configure the Generic and Digital point parameters for 

each point (refer to Generic Point Parameters earlier in this chapter). 

DS5PA Health Points 

Each configured DS5PA port, has one DS5PA health point for the entire port, and a health 

point assigned to each configured DS5PA station. Communication failures with individual 

stations result in the associated health point being alarmed. If all stations on a port fail then 

the port health point is alarmed.  

Table 7 lists the AID, point description, severity, and normal state of DS5PA health points. 

The x in the AID and point description represents the serial port number (1-8, 11-26); the y 

in the point description represents the station on the DS5PA device (1 – 254). For 

example, HEALTH-7-1 would represent the DS5PA Health point for serial port 7, DS5000 

station 1, and its default point description would be DS5PA PORT 7 STN 1. 

 

AID Point Description Severity Normal State 

HEALTH–x DS5PA PORT x FAIL CR Open 

HEALTH–x–y DS5PA PORT x STN y MJ Open 

Table 7 DS5PA Health Point Configuration 

Editing DS5PA Health Points 

To edit the DS5PA Health points: 

1. Select the Serial Ports tab and select the DS5PA port to be edited from the Select 

Port list. 



Metago Manager — Configuring DS5PA Devices  

100  994-T061 Rev Q  –  March 2016 

2. Click the Edit Devices button. The DS5PA Configuration window appears. 

3. Click the Health button. The Edit Point Parameters window appears. 

 

4. Configure each DS5PA Health point by selecting the point in the point list then 

configuring the Generic and Digital point parameters for each point. Refer to Generic 

Point Parameters earlier in this chapter for the definitions of the parameters. 
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DS5PA TBOS Points 

For each DS5PA TBOS input and output point, there is an AID field. The AID is a read-

only field that is automatically created by Metago
®
 Manager. The AID types are: 

DS5T-<v>-<w>-<x>-<y>-<z> (TBOS inputs) and 

DS5TC-<v>-<w>-<x>-<y>-<z> (TBOS outputs)  

Where: 

v =  the WS3500 serial port (1-8, 11-26) 

w = the DS5000 station number (1-254) 

x = the DS5000 downstream TBOS port (1-8) 

y = the DS5000 downstream TBOS display (1-8) 

z = point number (1-64) 

Editing DS5PA TBOS Points 

To edit DS5PA TBOS points: 

1. Select the Serial Ports tab and select the DS5PA port to be edited from the Select 

Port list. 

2. Click the Edit Devices button. The DS5PA Configuration window appears. 

3. Select the station to be edited from the Station List, and then click the TBOS Ports 

button. The DS5PA TBOS Ports window appears. 

4. Click the desired Port button. The DS5PA TBOS Displays window appears. 

5. Click the desired Display button. The Edit Parameters window appears. 
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6. Configure the points, either by applying a template (refer to Using Metago 

Manager Templates – Chapter 17) or by editing the points individually. Select the 

point from the point list, then configure the Generic and Digital point parameters 

for each point (refer to Generic Point Parameters earlier in this chapter). 
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Enabling and Disabling DS5PA TBOS Points 

To enable, disable or report in InSite only all DS5PA TBOS inputs in a display: 

1. Select the Serial Ports tab. 

2. Select the DS5PA port to be edited from the Select Port list. 

3. Click the Edit Devices button. 

4. Select the DS5PA station to be edited from the list. 

5. Click the TBOS Ports button. 

6. Click the desired TBOS port button. 

7. Click the desired display button.  The Edit Points Parameters window appears. 

8. Right-click in the point list and a drop-down menu appears with the options 

Disable All, Enable All and InSite Only All. 

9. Select the Enable All to enable all points in the point list, Disable All to disable all 

points in the point list or InSite Only to make all the points in the point list report in 

InSite only.  

The color of the circle in the leftmost column indicates whether the point is enabled or 

disabled.  Green indicates the point is enabled, red indicated the point is disabled and 

purple indicates the point is InSite only. 

DS5PA Analog Inputs 

For each DS5PA Analog input point, there is an AID field. The AID is a read-only field that 

is automatically created by Metago
®
 Manager. The AID types are: 

DS5PAA-<X>-<y>-<z>  

Where: 

x = the WS3500 serial port (1-8, 11-26) 

y = the DS5000 station number (1-254) 

z = the DS5000 analog input point number (1-64) 

 

Editing Analog Inputs 

To edit DS5PA inputs, 

4. Select the Serial Ports tab. 

5. Select the DS5PA Port to be edited from the Select Port list. 

6. Select the station to be edited from the Station List, and then click the Analogs button. 

7. Select the Analog shelf to be edited. 
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8. Select the Line # which contains the Analog inputs to be edited. The Edit Point 

Parameters window appears. 

 

9. Configure the points, either by applying a (refer to Using Metago Manager Templates 

– Chapter 17) or by editing the points individually. Select the point from the point list, 

then configure the Generic (refer to Generic Point Parameters earlier in this chapter) 

and Analog point parameters for each point. 

Analog Parameters 

The DS5000 analogs are based on a 4-bit analog/digital converter.  For all inputs, the 

Zero value is 0 and the Span is up to 16,383, depending on the Analog Type set in 

the DS5000 for each point (Refer to DS5000 documentation for Analog Types). 

Recommened Span value for Type 4 Analogs is 1000 and for Type 16 is 5998. 

 Zero  The minimum raw data value provided by the DS5000. 

 Span  The span of the raw data provided by the DS5000. The formula for 

calculating Span is 

Span = Maximum raw data value - Minimum raw data value 

 EngZero  The scaled data value corresponding to the Zero value. 

 EngSpan  The span of the scaled data for this input. The formula for calculating 

EngSpan is 

EngSpan = Maximum scaled data value - EngZero 

 Deadband  The deadband value is used to keep an analog point from being 

inadvertently reported as a change of state when the input fluctuates slightly.  A 

change of state will be reported only when the analog value has exceeded the 

threshold by a value greater than the deadband. 
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Alarm Processing Parameters  

 Alarm  Each analog point has four alarm thresholds: high-high (HI HI), high 

(HI), low (LO), and low-low (LO LO).  

 Value  For each threshold, enter the scaled threshold value. An alarm will be 

reported when the analog value has crossed the configured threshold value + the 

deadband. 

 Severity  An alarm severity can be assigned for each alarm threshold.  

 SA  Each threshold can be designated as either SA (service affecting) or NSA 

(non service affecting).  



Metago Manager — Configuring E2A Devices 

994-T061 Rev Q – March 2016  106 

 

This page was intentionally left blank



Metago Manager — Configuring E2A Devices 

994-T061 Rev Q – March 2016  107 

 

Configuring E2A Devices 

Serial/202T Modem ports configured as E2A (E-Telemetry) poll downstream RTUs using 

the E2A protocol.  

This section describes how to configure E2A serial/202T modem ports, including remote 

addresses, displays, outputs and health points. 

Adding E2A devices 

1. Select the Serial Ports tab and either create an E2A Collection port or select one from 

the Select Port list. 

       

Figure 31 – Serial/202T Modem Ports – E2A Device 

2. Click the Edit Devices button to configure the devices connected to the selected port. 

The E2A Configuration window appears. 

 

Figure 32 E2A Configuration dialog box 
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3. Click the Add button beside the Remote Address list to add a new remote device. The 

Adding a Device window appears. 

 

Enter values for the following fields:  

 Remote   The E2A remote address. The supported range is 1 to 256.  

 Location  The Location (CLLI code) is a freeform text field that is reported in the 

TL-1 alarm message. The CLLI code is a maximum of 11 characters long and is 

used to identify the site location of an alarm. 

 WG  The WG is a two-character text field that is reported in the TL-1 alarm 

message. 

4. Click OK to close the Adding a Device window. The E2A Configuration window 

reappears with the new address displayed in the Remote Addresses list. A default 

display number 5 is also added with every Remote Address because at least one 

display is required for a remote address. 

 

Adding E2A Displays 

1. Select the Serial Ports tab and select an E2A port from the Select Port list. 

2. Click the Edit Devices button. The E2A Configuration pop-up window appears. 
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3. Select the Remote Address you wish to add the new display to and click the Add 

button.  The following pop-up window will appear. 

 

Enter values for the following fields:  

 Add Display #   The E2A Display number. The supported range is 5 to 64.  

 Location  The Location (CLLI code) is a freeform text field that is reported in the 

TL-1 alarm message. The CLLI code is a maximum of 11 characters long and is 

used to identify the site location of an alarm. 

 WG  The WG is a two-character text field that is reported in the TL-1 alarm 

message. 

 Output Points – The Output Points check box should be checked if this display 

has output points. 

4. Click OK to add the display. 

5. Click the Close button to close the E2A Configuration window. 

Deleting E2A Displays 

1. Select the Serial Ports tab and select an E2A port from the Select Port list. 

2. Click the Edit Devices button. The E2A Collection Configuration pop-up window 

appears. 

3. Select the display you wish to delete from the Displays list and click the Delete button. 

A confirmation dialog box appears. 

 

4. Click OK to confirm the deletion.  

5. Click the Close button to close the E2A Collection Configuration window. 

E2A Inputs 

For each E2A input point, there is an AID field. The AID is a read-only field that is 

automatically created by Metago
®
 Manager.  For E2A input points, the format of the AID is 

TABS-<port>-<address>-<display>-<point number>, where port is the serial 

port number (11-18), address is the device address number (1-256), display is the display 
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number (1-64), and point number is the E2A point number (1-64). For example, E2A-11-1-

5-64 indicates that the E2A point is configured on serial port 11, address 1, display 5, and 

it is input point 64. 

Editing E2A Inputs 

When an E2A display is created, 64 input points are automatically added. To edit these 

inputs: 

1. Select the Serial Ports tab and select the E2A port to be edited from the Select Port 

list. 

2. Click the Edit Devices button. The E2A Configuration window appears. 

3. Select the appropriate E2A display from the Displays list and click the Inputs button. 

The Edit Point Parameter window appears. 

 

Figure 33 - Edit Point Parameters – E2A Inputs 

4. Configure the points either by applying a template (refer to Using Metago Manager 

Templates – Chapter 17) or by editing the points individually. Select the point from the 

point list then configure the Generic and Digital point parameters for each point.  

Generic point parameters  

Note: Some of the fields in the generic point parameters panel are populated when 

you created the E2A device.  Depending on the license purchased from Westronic, 

not all fields may be displayed. 

 Alarm / Event / Alarm-Env  The Alarm, Event and Alarm-Environmental radio 

buttons configure whether the point is reported as an alarm, as an event or as an 

environmental alarm. See Appendix C, “Generic Point Parameters” for more 

information about how these reporting states differ. 

 Point Description  The Point Description field is a freeform text field to be used 

for a description of the point. Maximum length is 50 characters (punctuation 

characters are not recommended).  
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 SID  The Source Identifier (SID) is a freeform text field that uniquely identifies a 

group of points.  The SID is used as the target identifier in the TL1 message 

header.  If the SID field is not configured, the RTU’s TID is used in its place. 

Maximum length is 20 characters. 

 AID Type  The AID Type is a freeform text field that can be used in conjunction 

with the AID to help identify a point.  This can be useful if the AID does not 

provide enough information to pinpoint the location of the point.  Maximum length 

is 10 characters. 

 Location  The Location is a freeform text field that is reported in the TL-1 alarm 

message.  This field is also referred to as the CLLI code, and is commonly used 

to identify the location of an alarm.  Maximum length is 11 characters.   

 WG  The workgroup (WG) is a two-character text field that is reported in the TL-

1 alarm message.  This field is commonly used to determine which workgroup or 

department needs to be notified when this point changes state. 

 Cond Type  The Cond Type is a freeform text field that identifies the type of 

alarm or event being reported.  Maximum length is 10 characters. 

 Units — A four-character text field, describing the measurement unit of the field 

device. This field is not generally used for digital points. 

 Reporting State — A dropdown menu with three options: Disabled (default), 

Enabled, and InSite Only. In this dropdown menu changes can be made on a 

point by point basis. “Enabling and Disabling all E2A Inputs” describes a per 

display method and is found later in this section.  

 An alarm point set to the “InSite Only” state will report only on the InSite 

alarm summary webpage and will not be reported via TL1 or SNMP.  

Any alarm point included in a derived alarm expression will have its 

reporting state set to InSite Only automatically.  

Note: The default state of newly configured E2A points is Disabled. Enabled or 

InSite Only must be selected from the dropdown list for the point to be reported 

when it changes state.  

 

Digital parameters  

 Severity — The severity field can be set to one of five levels.  From highest to 

lowest severity, the levels are CR (Critical), MJ (Major), MN (Minor), RN 

(Routine), NA (Not Alarmed).  

 Normal State — The Normal State radio buttons are used to indicate which state 

is considered to be normal, and conversely, which state indicates an alarm 

condition. The default configuration is normally open, where a closed contact 

indicates an alarm. 

 Service Affecting— The Service Affecting radio buttons configure the point to be 

either SA (Service Affecting) or NSA (Non-Service Affecting). 
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Download button 

This button enables the Manager user to update parameters of an individual point without 

the need to download an entire configuration and restart the WS3500. Please refer to 

Appendix B for more information on “Point on the Fly” usage.   

 

Enabling and Disabling all E2A Inputs 

To Enable, Disable or report in InSite only all E2A inputs in a display: 

1. Select the Serial Ports tab. 

2. Select the E2A port to be edited from the Select Port list. 

3. Click the Edit Devices button. 

4. Select the E2A display to be edited from the list. 

5. Click the appropriate button, Inputs, Outputs, or Health. The Edit Points Parameters 

window appears. 

6. Right- click in the point list, and a drop-down menu appears with the options Disable 

All, Enable All and InSite Only All. Two other options also appear in this drop down 

menu: Import Points… and Export Points…  For more information on Import/Export 

please refer to Chapter 17 – “Using Templates”. 

7. Select the Enable All to enable all points in the point list, Disable All to disable all 

points in the point list or InSite Only to make all the points in the point list report in 

InSite only.  

The color of the circle in the leftmost column indicates whether the point is enabled or 

disabled.  Green indicates the point is enabled, red indicated the point is disabled and 

purple indicates the point is InSite only. 
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E2A Outputs 

For each E2A output point, there is an AID field. The AID is a read-only field that is 

automatically created by Metago
®
 Manager. For E2A output points the format of the AID is 

E2AC-<port>-<address>-<display>-<point number>, where port is the serial 

port number (11-18), address is the device address (1-256), display is the display number 

(1-64), and point number is the E2A point number (1-64). For example, E2AC-11-1-1-64 

indicates that the E2A point is configured on serial port 11, address 1, display 1, and it is 

output point 64. 

Editing E2A Outputs 

When creating an E2A display, the user is given the option of automatically creating 64 

output points.  If the output points are not added at that time, they can be added later. 

To edit E2A output points: 

1. Select the Serial Ports tab and select the E2A port to be edited from the Select Port 

list. 

2. Click the Edit Devices button. The E2A Configuration window appears. 

3. Select the E2A display to be edited from the Displays list and click the Outputs button. 

If the output points were not added when the E2A device was created, the following 

message box appears: 

 

Click OK to add the output points.  

4. The Edit Point Parameters window appears. 
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Figure 34 - Edit Point Parameters – E2A Outputs 

5. Configure the points either by applying a template (refer to Using Metago Manager 

Templates – Chapter 17) or by editing the points individually. Select the point to be 

edited from the point list then configure the Generic and Digital point parameters for 

each point. Refer to “Generic Point Parameters” earlier in this chapter for definitions of 

the parameters. 

E2A Health Points 

Each configured E2A port, has one E2A health point for the entire port, and a health point 

assigned to each configured E2A address. Communication failures with individual address 

will result in the associated health point being alarmed. If all devices on a port fail, then the 

port health point is alarmed.  

Table 7 lists examples of AID, point description, severity, and normal state parameters for 

E2A health points. The x in the AID and point description represents the serial port 

number; the y represents E2A device addresses (0 – 31). For example, HEALTH-7-1 

would represent an E2A device on serial port 7, at address 1 and the default point 

description would be E2A PORT 7 ADDR 1. 

AID Point Description Severity Normal State 

HEALTH–x E2A Collection x FAIL CR Open 

HEALTH–x–y E2A Coll Port x Remote Address y MJ Open 

Table 8 E2A Health Point Configuration 

Editing E2A Health Points 

To edit E2A Health points,  

1. Select the Serial Ports tab and select the E2A port to be edited from the Select Port 

list. 

2. Click the Edit Devices button. The E2A Configuration window appears. 
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3. Click the Health button. The Edit Point Parameters window appears. 

 

4. Configure E2A Health points by selecting the point from the point list, then configuring 

the Generic and Digital point parameters for each point. Refer to “Generic Point 

Parameters” earlier in this chapter for definitions of the parameters and more 

information. 
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. 

Configuring Derived Alarms 

The WS3500 derived alarm system can take information from a large number of alarms 
and process that information to generate fewer but more meaningful alarms.  It uses a 
simple system of binary logic to accomplish this.   
 

Adding / Editing Derived Alarms 

 
1. To add/edit derived alarms select the Derived Alarms button from the I/O Correlation 

tab. This brings up the derived alarm form.   
 

 

Figure 35 - Edit Point Parameters – Derived Alarms 

2. Select ‘Add Point’ to add a derived point. To edit a derived alarm highlight the derived 
alarm and click ‘View Edit’.  This will bring up the Add / Edit Derived Points Form. 
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3. The derived expression can be input/edited here and must meet the requirements of 
the parsing engine (described below).   

a. The Existing Points and Operator drop down boxes can be used to simplify 
the process.   

i. The Existing Points drop down box will show all available AIDs for 
the current equation, including previous derived alarms.   

ii. The Operator drop down box will fill in the correct characters for the 
selected operator but will require that the AIDS be typed in.  

b. Every expression and normal operator (i.e. not brackets) must be clearly 
separated by a space.  

i. In Example “A OR B” is acceptable however “AORB” is not.  
4. Once the expression is input/edited as desired, select OK.  If no errors are found this 

will add/modify the derived alarm and change the alarm reporting state of the involved 
alarms to InSite Only.  

  
 

Parsing Engine 

 

When the Operator dropdown menu is clicked on, a list of available Operators is displayed 

as illustrated in the screenshot below: 

 

  

Operators 

( ) Brackets – These are special case operators as they do not affect truth on their own.  
Instead they allow for controlling order of operations within this parsing engine.  They 
require one expression and follow the form: ( A ) 
 
There is no simple truth table example for brackets.  See the section ‘Order of Operations’ 
later in this chapter to get an idea of how brackets work. 
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AND – This is the binary logical ‘and’ operator.  It requires two expressions and follows the 
form:   A AND B 
 
The truth table for AND is as follows: 
 

A B A AND B 

0 0 0 

0 1 0 

1 0 0 

1 1 1 

 
 
OR – This is the binary logical ‘or’ operator.  It requires two expressions and follows the 
form:   A OR B 
 
The truth table for OR follows: 
 

A B A OR B 

0 0 0 

0 1 1 

1 0 1 

1 1 1 

 
 
NOT – This is the unary logical ‘not’ operator.  It requires one expression and follows the 
form:   NOT A 
 
The truth table for NOT is as follows: 
 

A NOT A 

1 0 

0 1 

 
 
 
#OF requires the number ‘#’ of desired members as well as a membership list of 
expressions.  The OF operator will be true if # or more members of its list are true.  
It follows the form: # OF ( A , B , C … ) 
  
 
A simple example of the #OF operator is 2 OF ( A , B , C ).  The truth table for this 
example follows: 
 

A B C 2 OF (A, B, C) 

0 0 0 0 

0 0 1 0 

0 1 0 0 

0 1 1 1 

1 0 0 0 

1 0 1 1 

1 1 0 1 

1 1 1 1 
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#XOF requires the exact number ‘#’ of desired members as well as a membership list of 
expressions.  The XOF operator will only be true if exactly # of members of its list are true. 
It follows the form: # XOF ( A , B , C ….. ) 
 
 
A simple example of the XOF operator is 2 XOF ( A , B , C ).  The truth table for this 
example follows: 
 
 

A B C 2 XOF 
(A,B,C) 

0 0 0 0 

0 0 1 0 

0 1 0 0 

0 1 1 1 

1 0 0 0 

1 0 1 1 

1 1 0 1 

1 1 1 0 

 
 
 
 
ANY will be True if any alarms in the Derived alarm you are configuring are active.  ANY 
alarms differ from other derived alarms in that they are global in nature (i.e. sample group 
is from the entire configuration of the WS3500, not from a specified list of members). As a 
result they do not require a list of members or the use of brackets. Using brackets with the 
ANY operators will generate an error message in Manager. 
 
A simple example of the ANY operator is  ANY    
 
 
The following expressions work in an identical manner except for the severity involved, so 
will be treated as a group. These expressions are a means of Derived Alarms filtering-in or 
filtering-out desired or undesired severities as may be required. 
 
The operators are: 
 
ANY_RN will be True when any alarms of severity RN or greater are active.  
 
ANY_MN will be True when any alarms of severity MN or greater are active. 
 
ANY_MJ will be True when any alarms of severity MJ or greater are active. 
 
ANY_CR will be True when any alarms of severity CR are active. 
 
 
The order of severity is:  CR > MJ > MN > RN 
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Order of operations 

 
Unless defined by brackets, the order of operations within this engine is strictly left to right.  
The normal operators ( i.e. not brackets ) have NO inherent precedence.  This is not 
typical of parsing engines and it is highly recommended that brackets be used in 
expressions with more than one operator in order to guarantee expected behavior.  
The brackets guarantee that the expression contained within will be fully evaluated before 
its value is considered in the surrounding expression. 
 
Examples follow to illustrate. 
 

First Example 

 
Expression entered: A AND B OR C 
 
Here is the expression again with brackets added to illustrate the left to right order of 
operations. : ( ( A AND B ) OR C ) 
 
So the truth table for this would be  
 

A B C A AND B OR C 

0 0 0 0 

0 0 1 1 

0 1 0 0 

0 1 1 1 

1 0 0 0 

1 0 1 1 

1 1 0 1 

1 1 1 1 

 

Second Example 

 
This will be very similar to the first example but this time with brackets added to change 
the order of operations. 
 
Expression entered: A AND ( B OR C ) 
 
This time the truth table would be as follows. 
 

A B C A AND ( B OR C ) 

0 0 0 0 

0 0 1 0 

0 1 0 0 

0 1 1 0 

1 0 0 0 

1 0 1 1 

1 1 0 1 

1 1 1 1 
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Menus 

File Menu 

 

Backup RTU 

RTU configurations created using Metago Manager are stored in a database. Any 

changes that are made to an RTU’s configuration are written to Metago Manager’s 

database.  To avoid accidental loss of RTU configuration data, either as a result of system 

failure, or user entry error, it is highly recommended to backup the RTU configurations 

frequently.  An RTU backup file consists of a .zip file containing RTU configuration files for 

all configured RTU parameters.  RTU backup files are portable, and can easily be 

archived for later use. These RTU backup files can be restored at any time to recover lost 

data 

To backup an RTU: 

1. Select the RTU to be backed up from the RTU list in Manager. 

2. Select Backup RTU from the File menu. A confirmation dialog box appears, showing 

the total number of points configured for the selected RTU. 

 

3. Click the Yes button to continue with the backup.  The Save As window appears. 

Chapter 
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4. Select to the target location where the backup is to be saved. By default, the file is 

saved on your PC in the C:\Program Files\Westronic\Metago Manager 

\backup folder. 

5. By default, the file name will be the RTU TID. This file name may be changed, but it is 

recommended that the file name should contain the TID (e.g. Current date could be 

appended to the file name from the above example: RTU121_012416.zip). The file is 

saved as a .zip file. Click the Save button to save the file and close the Save As 

window. 

An Information dialog box appears indicating a successful operation. 

 

6. Click the Ok button to close the dialog box. 

Restore RTU 

To restore an RTU from a backup file, the currently configured TID of the selected RTU in 

Metago Manager must match the TID contained in the RTU backup file. 

To restore an RTU: 

1. Select the RTU to be restored from the Select RTU list. 

2. Select Restore RTU from the File menu. A confirmation dialog box appears. 
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3. Click the OK button to continue.  The Open window appears. 

 

4. Select the location of the RTU Backup file to be opened. (Use the Look in drop-down 

list or the buttons in the Open dialog box to locate the folder). 

5. In the File name text box, type the name of the RTU backup vile to be opened, or 

select the file from the list. 

6. Click the Open button to open the file.  

An Information dialog box appears indicating a successful operation, as well as how 

many points were restored from the backup file. 

 

7. Click the OK button to close the dialog box. The RTU configuration and database will 

be restored from the backup file and displayed in the various Tabs. 
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Exit 

The Exit option in the File menu allows the user to exit Metago Manager.  A confirmation 

dialog box appears. 

 

Click OK to close Metago Manager. 

Options Menu  

 

Enter license key … 

With this option, the user can enter a new license key for Metago Manager. This option 

should only be used if you have purchased a new Metago Manager License from 

Westronic.  These keys allow or restrict access to certain features within Metago Manager.  

The ownership of these license keys is tracked by Westronic; only authorized license keys 

should be used with Metago Manager.  Entering an invalid license key may render the 

application unusable. 

To enter a new license key: 

1. Select Enter license key from the Tools menu.  The License Key window appears.  
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2. Enter the license key as it was sent by Westronic, in upper case letters. 

3. Click OK to close the License Key window.  A dialog box appears. 

 

4. Click OK to close the dialog box.  Exit and re-open Metago Manager for changes to 

take effect. 

View Log file 

With this option, you can view the RTU transaction log files stored on the PC. 

The RTU transaction log files contain a record of all the operations that affect the RTU. 

These log files are named according to the TID of the RTU. 

The log files are stored in the Metago Manager\logs directory. The operations that are 

documented in the log files are connection, disconnection, update config, upgrade image, 

file download, and any Winsock errors. These log files can be useful in determining where 

an error occurred in a certain process. 

Note: The user is responsible for the management of the log files. Depending on the 

number of operations, these files could grow in number and size, so they need to be 

monitored and archived if necessary. 

To view an RTU Log file,  

1. Select View Log file from the Options item in the menu bar. The Open window 

appears: 
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2. Select the folder for the RTU. The folder name is the RTU TID.  Within each folder, 

the names of the files will contain the RTU TID and the date. The date will be in the 

format of ddmmyy.  

3. Select the file you wish to view and then click the Open button. The RTU log file 

appears in a text editor.  

Following is an example of a RTU Transaction log file for RTU121. 

//========================================================== 

// RTU TRANSACTION LOG 

//---------------------------------------------------------- 

// TID: RTU121 

//========================================================== 

 

02/22/04, 14:00:37>  !!! Error 

Winsock Connect Error! 

The attempt to connect timed out. 

02/22/04, 14:03:17>  !!! Error 

Winsock Connect Error! 

The attempt to connect timed out. 

02/22/04, 14:04:30>  Connected to RTU: RTU121 (172.16.6.121:26) 

02/22/04, 14:04:37>  User: MTC logged in (level 5) 

 

 

AID Type … 

NOTE:  Depending on the license purchased from Westronic, this option may not be 

available.  Any options that are not available may be ignored in this document. 

The AID Type is a freeform text field that can be used in conjunction with the AID to help 

identify a point.  This can be useful if the AID does not provide enough information to 

pinpoint the location of the point.  Maximum length is 10 characters.  The AID Type list is 

global to all RTUs in Metago Manager. 

To create a new AID Type: 

1. Select AID Type from the Options menu. The AID Type window appears. 
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2. Click the Add button. 

3. Enter the AID Type in the text box. 

4. Click the Save button to save the definition. The new AID Type will now be in the list. 

To modify an AID Type: 

1. Select AID Type from the Options menu. The AID Type window appears. 

2. Select the AID Type to be edited from the list.  Click the Edit button.  

3. Modify the AID Type. 

4. Click the Save button to save the definition. The modified AID Type will now be in the 

list. 

To delete an AID Type: 

1. Select AID Type from the Options menu. The AID Type window appears. 

2. Select the AID Type to be deleted from the list. 

3. Click the Delete button to remove the definition. If the selected AID Type is currently 

used on any RTU in Metago Manager, it will not be deleted.  Otherwise, the AID Type 

will be deleted from the list. 
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Condition Type 

NOTE:  Depending on the license purchased from Westronic, this option may not be 

available.  Any options that are not available may be ignored in this document. 

The Condition Type is a freeform text field that identifies the type of alarm or event being 

reported.  Maximum length is 10 characters.  The Condition type list is global to all RTUs 

configured in Metago Manager. 

To create a new Condition Type: 

1. Select Condition Type from the Options menu. The Condition Type window appears. 

 

2. Click the Add button. 

3. Enter the Condition Type in the text box. 

4. Click the Save button to save the definition. The new Condition Type will now be in 

the list. 

To modify a Condition Type: 

1. Select Condition Type from the Options menu. The Condition Type window appears. 

2. Select the Condition Type to be edited from the list.  Click the Edit button.  

3. Modify the Condition Type. 

4. Click the Save button to save the definition. The modified Condition Type will now be 

in the list. 

To delete a Condition Type: 

NOTE:  There are two default Condition Type entries that cannot be deleted, they are GP, 

and TH. 

1. Select Condition Type from the Options menu. The Condition Type window appears. 

2. Select the Condition Type to be deleted from the list. 
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3. Click the Delete button to remove the definition. If the selected Condition Type is 

currently used on any RTU in Metago Manager, it will not be deleted.  Otherwise, the 

Condition Type will be deleted from the list. 

Workgroups 

The Workgroups item allows the user to define the two-character workgroup (WG) text 

field that is reported in the TL-1 alarm message. This field is commonly used to determine 

which workgroup or department needs to be notified when this point changes state.  The 

workgroup is often used as a filtering parameter for alarms. The Workgroup list is global to 

all RTUs in Metago Manager. 

To create a new workgroup: 

1. Select Workgroups from the Options menu. The Workgroups window appears. 

 

2. Click the Add button. 

3. Enter a description of the workgroup in the Description text box. 

4. Enter a 2-character acronym for the workgroup in the WG text box. 

5. Click the Save button to save the definition. The workgroup will now be in the list of 

workgroups. 

To modify a workgroup: 

1. Select Workgroups from the Options menu. The Workgroups window appears. 

2. Select the workgroup to be edited from the list.  Click the Edit button.  

3. Modify the description and/or WG fields. 

4. Click the Save button to save the definition. The modified workgroup will now be in the 

list of workgroups. 

To delete a workgroup: 

1. Select Workgroups from the Options menu. The Workgroups window appears. 

2. Select the workgroup to be deleted from the list. 
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3. Click the Delete button to remove the definition. The workgroup will be deleted from 

the list of workgroups. 

SID 

NOTE:  Depending on the license purchased from Westronic, this option may not be 

available.  Any options that are not available may be ignored in this document. 

The Source Identifier (SID) is a freeform text field that uniquely identifies a group of points.  

The SID is used as the target identifier in the TL1 message header.  If the SID field is not 

configured, the RTU’s TID is used in its place. Maximum length is 20 characters.  The SID 

list is RTU specific. 

To create a new SID: 

1. Select SID from the Options menu. The SID window appears. 

 

2. Click the Add button. 

3. Enter the SID in the text box. 

4. Click the Save button to save the definition. The new SID will now be in the list. 

To modify an SID: 

1. Select SID from the Options menu. The SID window appears. 

2. Select the SID to be edited from the list.  Click the Edit button.  

3. Modify the SID. 

4. Click the Save button to save the definition. The modified SID will now be in the list. 

To delete an SID: 

1. Select SID from the Options menu. The SID window appears. 

2. Select the SID to be deleted from the list. 

3. Click the Delete button to remove the definition. If the selected SID is currently used 

on the selected RTU in Metago Manager, it will not be deleted.  Otherwise, the SID 

will be deleted from the list. 
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Application timeout 

The Application timeout option allows the user to enable or disable the inactivity timeout 

feature. If the feature is enabled, when Metago Manager is idle (no keystrokes or mouse 

movement) for the configured interval, any RTU connection is terminated and Metago 

Manager closes. It is highly recommended to enable this feature with a practical duration 

such as 30 minutes. This will prevent an unattended/forgotten instance of Manager from 

tying up a WS3500 and leaving it unable to be configured by any other user on the 

network. 

To configure the application timeout feature: 

1. Select Application timeout from the Options menu. The Application timeout 

configuration window appears. 

 

2. Click the Enable application timeout checkbox. 

3. Enter the time inactivity time in minutes (or select using the arrow buttons). 

4. Click the OK button to close the window. If Metago Manager is idle (no keystrokes or 

mouse movement) for the configured amount of time, a Timeout notification window 

appears warning you that Metago Manager will terminate in 15 seconds. To stop the 

application from closing, click the Cancel button. 

 

To disable the application timeout feature: 

1. Select Application timeout from the Options menu. The Application timeout 

configuration window appears. 

2. Click the Enable application timeout checkbox and remove the check mark. 

3. Click the OK button to close the window. 
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Change DB Partition 

NOTE:  Depending on the license purchased from Westronic, this option may not be 

available.  Any options that are not available may be ignored in this document. 

The typical installation of Metago Manager uses a database that is on the same PC as the 

installation itself. This is geared toward an environment where only one person requires 

access, or when the PC is in a shared area, to be accessed by several different users. 

An alternate installation is where the database is installed on a shared network drive, 

which is accessible by more than one user. In this configuration, multiple database 

partitions may be defined. Each database partition may be accessible to multiple users, 

but only one user can access a particular partition at a time. 

The Change DB Partition menu option allows the user to create or select a different 

Metago Manager database. 

To switch to a different database partition: 

1. Select Change DB Partition from the Options menu.  The Select a database partition 

window appears. 

 

2. The left list column contains a freeform text description of the database partition; the 

right column contains the database path.  Select the desired database partition from 

the list. 

3. Click the Select button to open the selected database partition.  This closes the Select 

a database partition window and returns to Metago Manager main window and opens 

the selected database. 

To add a new database partition: 

1. Select Change DB Partition from the Options menu.  The Select a database partition 

window appears. 

2. Click the Add button.  This enables the Edit Selection section. 
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3. Enter a descriptive name for the new database partition. 

4. Enter the database path, or browse using the … button. 

5. Click the Save button to add the new database partition to the list. 

NOTE:  If the selected Path does not exist, the user is asked if it should be created.  

 

NOTE:   If the path exists, but does not contain a valid Metago Manager database, the 

user is asked if a default database should be copied to the selected location 
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To delete a database partition: 

NOTE:  The actual database files are not deleted, only the list entry in the Select a 

database partition window is removed. 

1. Select Change DB Partition from the Options menu.  The Select a database partition 

window appears. 

2. Select the database partition to be deleted. 

3. Click the delete button.  A confirmation dialog box appears. 

 

4. Click OK to delete the database partition. 

 

 

Connection timeout 

The Connection timeout menu allows the user to change the timing for specific aspects of 
file movement in the Metago Manager application. Westronic recommends these timeouts 
are left at default values for all TCP/IP connected WS3500’s. Please contact Westronic 
Technical support for additional information.  

 

 
 
 

To configure the application timeout feature: 

1. Select Application timeout from the Options menu. The Application timeout 

configuration window appears. 

2. Click “Use Default Values” 

3. Close the Upload/Download Timeout window. 
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Help Menu 

 

About 

The About item in the Help menu displays the Metago Manager about window. This is 

where the Metago Manager version number is found.  

Hit ‘OK” or the X to close this window. 
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Using Metago Manager Templates 

A template is a file that contains a series of point configurations.  If the same series of 

points will occur on several devices, a template can be created to simplify the creation and 

maintenance of those devices.  Metago Manager templates can be imported and exported 

from within the desired Edit Point Parameters window of Metago Manager. 

The template file is a comma separated value file (.csv file), which can be viewed and 

edited using a standard text editor, or Microsoft
® 

Excel. Refer to Appendix A for an 

example of a Metago Manager .csv template file. 

NOTE: Templates are only available in Metago Manager.  The import/export options 

are not present in Metago Manager LITE. 

 

Exporting Metago Manager Template Files 

Exporting point templates is done from the Edit Point Parameters window. For more 

information on displaying the Edit Point Parameters window for specific device types, refer 

to the section of this manual that deals with that specific device. 

To export a template file:  

1. Proceed to the Edit Point Parameters window. 

 

Chapter 
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2. Right-click in the point list, and select Export Points from the pop-up menu.  The 

Export  Points window appears. 

 

3. In the Export Points window, select where to start exporting the point configurations 

(Start Point text field) and the number of points (Range) to export.  

 In the Start Point text box, type the starting point number or use the up and down 

arrow buttons to select the starting point number. 

 In the Range text box, type the number of points to export or use the up and 

down arrow buttons to select the number of points to export. 

4. Click the OK button to close the Export window. The Save As window appears. 

 

5. Select to the target location for the export file.  

6. In the File name textbox, enter the name of the file. The file is automatically saved as 

a comma separated value (.csv) file.  

Note: Wherever possible, try to use descriptive filenames to facilitate future use of 

these template files.  

7. Click the Save button to save the file and close the Save As window. 

An Information dialog box appears indicating a successful operation. 
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8. Click OK to close the dialog box.  

Importing Metago Manager Template Files 

Importing point templates is done from the Edit Point Parameters window. For more 

information on displaying the Edit Point Parameters window for specific device types, refer 

to the section of this manual that deals with that specific device. 

To export a template file,  

1. Proceed to the Edit Point Parameters Window. 

 

2. Right-click in the point list, and select Import Points from the pop-up menu. The Open 

window appears. 
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3. Select the location of the file to open. (Use the Look in drop-down list or the buttons in 

the Open dialog box to locate the folder.) 

4. In the File name text box, type the name of the file to open, or select the file from the 

list. 

5. Click the Open button to open the file. 

6. The Import Points window appears. 

 

 

7. In the Import Points window, select where to start applying the point definitions and 

the number of points you want to import.  

 In the Start Point text box, type the starting point number or use the up and down 

arrow buttons to select the starting point number. 

 In the Range text box, type the number of points to import or use the up and 

down arrow buttons. 

 The CLLI field is an optional field. The CLLI is an 11-character freeform text field 

that is reported in the TL-1 alarm message. The CLLI is commonly used to 

identify the site location of the alarm point. The CLLI code will be applied to all the 
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points that you are importing. If the text box is left blank, no CLLI will be applied to 

any of the imported points. 

8. Click the OK button to close the window. An information dialog box appears indicating 

a successful operation. 

 

9. Click the Ok button to close the dialog box.  
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DB Loader 

DB loader is a utility which is installed on the PC with Metago Manager. This utility is able 

to import and export template files in a .CSV format for easy manipulation in Excel. Files 

from DB Loader are different to those discussed in the previous chapter. Files from DB 

Loader include all fields from every alarm point in the system. 

IMPORTANT NOTE: As DB loader uses the same database as Metago Manager it is 

not possible to run both applications at the same time.  

Typically the desired RTU would be selected from the TID list as shown in the screenshots 

below. You would then choose to export or import points as appropriate; either exporting 

from the given RTU file for manipulation, or importing back to the given RTU file for saving 

or uploading to the unit. 

 

DBLoader Use-Cases 

The following outlines some specific use-cases for DBLoader: 

 

 DBloader WILL handle the case where an imported CSV file does NOT include all configured 

points. When it encounters this: 

 It will make the appropriate changes to the points that are included.  

 It will NOT remove the points that are not included.  

 DBloader WILL handle the case where points are included in the CSV but not in the 

configuration. HOWEVER IT WILL NOT ADD THE POINTS TO THE CONFIGURATION. 

THEY MUST BE ADDED THROUGH MANAGER. When DB Loader    encounters this: 

 It will work normally on points that ARE included in the configuration. 

 For points that are in the CSV but NOT in the configuration it will generate a warning. 

 DBloader WILL handle the case where the data entered by a field is too large. In this case: 

 It will shorten the data to fit. 

 The order of points in the CSV file is NOT important. They may be in any order. 
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Exporting Points to .CSV with DBLoader 

To export a points database file,  

1. Ensure Metago Manager is closed, then open DBLoader 

2. Select the desired RTU from the TID list 

3. Click on the “Export Points” tab then on the ‘Export’ radio button. 

4. A standard file save menu will open with the current TID as the offered name. Save 

the file by name and location as appropriate. 

5. The .CSV file is now ready for use. 
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Importing Points from  a .CSV file with DBLoader 

To Import a .CSV file,  

1. Ensure Metago Manager is closed, then open DBLoader 

2. Select the desired RTU from the TID list 

3. Click on the “Import Points” tab then on the ‘Browse’ radio button. A standard file 

selection menu will open, select the desired .CSV file and click on the ‘Open’ button in 

the file window. 

 

 

 

4. Once verified the correct file is selected, click on the “Import” radio button in the 

DBLoader screen. 

5. The Progress bar in the lower right of the screen will show “Validating Data File” and a 

new sub-window called “Added Types” will open. If no new types have been added to 

the RTU, this window will be empty as shown below. Click OK. 
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6. If new types have been added to the RTU, then the Added Types sub-window will 

show what types have been added as in the example below. 

 

 

 

7. Once OK has been clicked in the Added Types window, another new window will 

open called “Validate Points”. The next two screenshots show examples of this 

window first with a file having no errors, and then with a file having errors because of a 

mismatch between the .csv file and the actual unit configuration. 
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8. Under “Continue importing points?” click OK or Cancel as appropriate. 

9. The progress bar will show that the points are being imported, followed by an 

information window as shown below when the process is complete. 

 

 

 

10. Click OK, the RTU file is now ready for use in Metago Manager. 
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Example of a .CSV file from DBLoader 

The following is an example of a .csv File from DBLoader containing over 300 Alarm points of various 

types. It is in comma delimited (.csv) format which can be viewed and modified using a standard text 

editor or Microsoft
®
 Excel.  This particular example has been size adjusted to show that an export 

from DBLoader will contain all the points configured in that unit such as: Discrete, TBOS, TABS, 

INACS, and DS5PA. 

In the following example there are 8 Discrete I/O points visible, along with 4 controls, a variety of 

Health points, TBOS points and TABS-IP collection points.  

 

The CSV file is very useful and powerful for changing point descriptions, SID’s, enabling or disabling 

points, changing workgroups and for templating from one unit to another.   

 

It is important to note that new points cannot be created in a .CSV file; they will not be 

successfully imported and will generate errors at the time of importing. 
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Examples of Metago Manager .csv Template Files 

The following is an example of a Metago Manager .csv Template File containing 35 digital points from 

a Discrete I/O module. This template is in comma delimited (.csv) format, and can be viewed and 

modified using a standard text editor or Microsoft
®
 Excel.  This template can be applied to any digital 

points, such as: Discrete, TBOS, TABS, INACS, and DS5PA. They can be imported/exported on a 

per-display basis from the specific “Edit Point Parameters” window, which is shown in many chapters 

throughout this manual. 

NOTE: Although similar in appearance to the DBLoader .CSV files, the usage of Metago Manager 

.CSV template file (as illustrated below) is not the same. Please refer to Chapter 17 for more 

information. 
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Point on the Fly Configuration 

On-the-fly Point Configuration 

On-the-fly point configuration provides the user with a way to update individual points on 

an RTU without re-downloading the entire database or having to bring the RTU offline. 

On-the-fly point configuration cannot be used to add or remove points from an RTU. It is 

intended to update the parameters of existing points that have already been downloaded 

to the RTU. 

For SID, AID Type, WG, and Cond Type fields, on-the-fly configuration is limited to 

selections that have already been downloaded to the RTU.  New values for these fields 

cannot be added with on-the fly configuration. Changes requiring such new values; or 

larger scale modifications to points will require a new configuration to be sent to the RTU 

in the typical manner. 

 

To update a point using on-the-fly configuration: 

1. Select the RTU to be updated from the Select RTU list box. 

2. Click the CONNECT button, and login to the RTU. 

3. Select the appropriate Edit Point Parameters window and find the desired point. 

 

 

 

 

 

Appendix 

B 



Metago Manager — Point on the Fly Configuration 

154  994-T061 Rev Q  –  March 2016 

4. Edit the point parameters as desired, and click the DOWNLOAD button to perform the 

update on the RTU. 

 

 

 

5. Click OK to continue the on-the-fly point configuration. 

 

 

 

6. Click OK to finish the process. 

7. Click the Close button to close the Edit Point Parameters window. 

8. Click the DISCONNECT button to disconnect from the RTU. 

9. The RTU will not go offline or need to be reset, and the operation is complete.
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Generic Point Parameters 

 

In the Edit Point Parameters windows within a WS3500 configuration are radio button 

options called ‘Generic Point Parameters’. From these the user has the option of choosing 

the point to be reported as an ‘Alarm’, an ‘Event’, or as an ‘Alarm-Env’ which is an 

Environmental alarm. The behavior of each is different both in the Edit Point Window and 

when reported via TL1. 

Edit Point Window Behavior 

With “Alarm” selected within an Edit Point Parameters window (default setting of 

Manager) all licensed fields are available for editing. The Edit Point Parameters window 

will appear as it is generally shown throughout this document. 

When the ‘Alarm-Env’ option has been selected  (for point 8 as is shown in the 

screenshot below) the window behavior for that point changes. Unlike the point 

configurations in most other examples within this document, several options on the tab for 

this alarm point are greyed out and not able to be changed.  

These are:    

 Location 

 WG 

 AID TYPE 

 SA/NSA  
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When the the ‘Event’ option has been selected (for point 7 as is shown in the screenshot 

below) the window behavior for that point also changes. Only one option on the tab is 

greyed out and cannot be changed.  

It is:    

 Severity 
 
 

 

  
 
 
 
For a more complete description of all the fields shown in above screenshots, please refer 
to ‘Generic Point Parameters’ in the “Discrete Tab” section of this manual.
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TL1 Retrieve Alarm and InSite Alarm Behavior 

The behavior of each is differs somewhat both in TL1 when Retrieve Alarm is used, and 

when viewed on the InSite web browser of the WS3500. The following is a summary of 

this behavior: 

When Generic Point Parameter checked as an Alarm or as an Event:    

 If the TL1 command ‘RTRV-ALM;’ is used, all points in Alarm and Events will be 
returned 

 If the TL1 command ‘RTRV-ALM-ENV;’ is used, no Alarms will be returned 

 Active Alarms and Events reports on InSite summary 

 Active Alarms and Events appear normally on I/O module InSite page 

 Active Alarms and Events appear normally on Browse Database InSite page 
 

 
 
When Generic Point Parameter checked as an Alarm-Env:    
 

 Any TL1 returns for Alarm-Env will have NSA only as SA not configurable 

 Any TL1 returns for Alarm-Env will have a blank WG field 

 Any TL1 returns for Alarm-Env will have a blank AID field 

 If the TL1 command ‘RTRV-ALM-ENV;’ is used, ONLY Alarm-Env points in alarm 
will be returned 

 If the TL1 command ‘RTRV-ALM;’ is used, all points in alarm INCLUDING Alarm-
Env points will be returned 

 Alarm-Env reports on InSite summary without any CLLI (Location)  

 Alarm-Env appears normally on I/O module InSite page 

 Alarm-Env appears normally on Browse Database InSite page 
 
 
NOTE: For information on autonomous Alarm, Event and Alarm-Environmental behavior, 
please refer to ” WS3500 Supported TL-1 Messages” – in Appendix A of the WS3500 
Technical manual.  
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Acronyms and Abbreviations 

This section contains the acronyms and abbreviations found throughout this manual. 

Although each acronym and abbreviation is explained when first introduced, this listing 

consolidates the acronyms and abbreviations. 

ACL Access Control List 

AID Access Identifier 

BLB Bank Loop Back 

CLI Command Line Interface 

CLLI Common Language Location Identifier. 

COT Central Office Terminal 

CPU Central Processor Unit 

CSV Comma Separated Value 

DCE Data Communications Equipment 

DNS Domain Name Server 

DS5PA DS5000 Protocol Acquisition 

DTE Data Terminal Equipment 

E2A E-Telemetry 

I/O Input/Output 

INACS Integrated Network Alarm & Control System 

LAN Local Area Network 

NE Network Element 

NIC Network Interface Controller 

NSA Not Service Affecting 

NTP Network Time Protocol 
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PC Personal Computer 

PIDs Parameter Identifiers 

PPP Point to Point Protocol 

RTU Remote Terminal Unit 

SA Service Affecting 

SID Station Identifier 

SLC Subscriber Loop Carrier 

SNMP Simple Network Management Protocol 

TABS Telemetry Asynchronous Block Serial 

TBOS Telemetry Byte Oriented Serial 

TCP/IP Transmission Control Protocol/Internet Protocol 

TID Target Identifier 

TL-1 Transaction Language 1 

TMN Telecommunications Network Management 

WG Work Group 
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